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Índice

Prefácio . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1
1. Sobre o Mandriva Linux . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1

1.1. Entrando em Contato com a Comunidade Mandriva Linux . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1
1.2. Junte-se ao Clube! . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1
1.3. Assinando o Mandriva Online . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2
1.4. Comprando Produtos Mandriva . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2
1.5. Contribuindo com o Mandriva Linux . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2

2. MCC’s Components . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2
3. Nota do Editor . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4
4. Convenções utilizadas neste livro. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .5

4.1. Convenções Tipográficas . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5
4.2. Convenções Gerais . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6

5. Managing Configuration Profiles . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7
5.1. Profile Handling . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7
5.2. Choosing a Profile at Boot Time . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7

6. The Drakbug Reporting Tool . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 8
1. Gerenciamento de Pacotes através do Rpmdrake. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .11

1.1. Instalando Programas . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 11
1.1.1. Selecionando Pacotes para Instalação . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 12
1.1.2. Procurando Pacotes . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 14

1.2. Removendo Programas . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 14
1.3. Atualizador do Mandriva Linux . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 15
1.4. O Gerenciador de Mídias de Programas . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 15

2. Controlling a Remote Machine . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 21
2.1. Concepts . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 21
2.2. Installation and Setup . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 21

2.2.1. Controlled Computer Setup . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 21
2.2.2. Controlling Computer Setup . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22

2.3. Connecting to a Windows® Terminal Server . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 24
2.4. Remote Control in Action. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .24
2.5. More Documentation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 25

3. “Hardware” Section. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 27
3.1. Configuring your Hardware . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 27

3.1.1. Hardware Detection and Configuration. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .27
3.1.2. Problems/Troubleshooting . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 28

3.2. Controlling the Graphical Configuration . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 28
3.2.1. Changing the Monitor . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 29
3.2.2. Changing Resolution . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 30
3.2.3. Controlling All Video Parameters . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .31

3.3. Setting up a TV Card with DrakxTV . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 32
3.4. Changing your Keyboard Layout . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 34
3.5. Changing your Mouse . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 34
3.6. Configuring Printers with PrinterDrake . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 35

3.6.1. Initial Configuration . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 35
3.6.2. The Printer Management Interface . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 37
3.6.3. Print Server General Configuration . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 38
3.6.4. The Printer Configuration Wizard . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 40
3.6.5. Reconfiguring an Existing Printer. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .43
3.6.6. Expert Mode . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 44

3.7. Installing and Using Scanners . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 45
3.7.1. Configuring your Scanner . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 46
3.7.2. Using Image Acquisition Software . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 48
3.7.3. Advanced Configuration . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 49
3.7.4. Other Scanner Interface Software . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 51

3.8. Setting up your UPS . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 51
4. “Network & Internet” Section . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 55

4.1. Network and Internet Connection Management . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 55

iii



4.1.1. Set Up a New Network Interface . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 55
4.1.2. Internet Settings . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 59
4.1.3. Reconfigure Interfaces . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 60
4.1.4. Monitoring Connections . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .60
4.1.5. Removing a Connection . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 61
4.1.6. Proxy Settings . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 61
4.1.7. Wireless Connection Management . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 61

4.2. Internet Connection Sharing . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 61
4.2.1. The Gateway Connection Wizard . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 62
4.2.2. Configuring the Clients . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 63

5. “System” Section . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 65
5.1. Customizing your Menus with MenuDrake . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 65

5.1.1. Adding a New Menu Entry. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .66
5.1.2. Advanced Features . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 68

5.2. Configuring Start-Up Services . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 69
5.3. Managing Available Fonts on your System with DrakFont . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 70
5.4. Setting your Machine’s Date and Time . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 71
5.5. Monitoring System Activity and Status . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 72

5.5.1. Browsing System Logs . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 72
5.5.2. Setting up Mail Alerts . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 73

5.6. Access to the Console . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .75
5.7. Managing Users and Groups . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 75

5.7.1. The Interface . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 75
5.7.2. Adding a New User . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 76

5.8. Backing Up and Restoring your Files . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 78
5.8.1. A Practical Example Using the Wizard . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 78
5.8.2. Restoring Backups . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 82
5.8.3. Automating Periodic Backups . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 82
5.8.4. Advanced Drakbackup Configuration . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 83

6. Pontos de Montagem e Diretórios Remotos . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 85
6.1. Managing your Hard Drive Partitions with DiskDrake . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 85

6.1.1. The Interface . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 85
6.1.2. DiskDrake’s action buttons . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 86
6.1.3. Resizing an Old Partition and Creating a New One . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 86

6.2. Managing Removable Devices . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 88
6.3. Importing Remote SMB Directories . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 89
6.4. Importing Remote NFS Directories . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 91
6.5. Allowing Users to Share Folders . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 91
6.6. Setting up WebDAV Mount Points . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 92

7. “Security” Section . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 95
7.1. Securing your Machine through DrakSec . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 95

7.1.1. Setting your Security Level . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 95
7.1.2. Customizing a Security Level . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 96

7.2. Controlling File Permissions with DrakPerm. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 97
7.3. Protegendo sua Conexão Internet com o DrakFirewall . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 98

8. “Boot” Section . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 101
8.1. Configuring the Login Mode . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 101
8.2. Changing your Bootup Configuration . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 101

8.2.1. Configuring the Bootloader . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 102
8.2.2. Managing Boot Entries . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 102

8.3. Customizing your Boot Theme . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 103
Índice Remissivo . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 105

iv



Lista de Tabelas

1. Overview of Graphical Tools . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3

v



vi



Prefácio

1. Sobre o Mandriva Linux

O Mandriva Linux é uma distribuição GNU/Linux produzida pela Mandriva S.A., que surgiu na internet em 1998
com o objetivo primário de fornecer um GNU/Linux amigável. Os dois pilares da Mandriva são trabalho de
código aberto e colaborativo.

Em 7 de abril de 2005 a Mandrakesoft mudou o seu nome para
Mandriva para refletir a fusão com a empresa Conectiva, com se-
de no Brasil. Seu produto principal, o Mandrakelinux, tornou-se o
Mandriva Linux.

1.1. Entrando em Contato com a Comunidade Mandriva Linux

Existem vários locais na internet onde você pode buscar por informações sobre o Mandriva Linux. Se você deseja
saber mais sobre a empresa Mandriva, acesse o nosso web site (http://www.mandriva.com/). Você também
pode verificar o web site da distribuição Mandriva Linux (http://www.mandrivalinux.com/) e seus derivados.

A Mandriva Expert (http://www.mandrivaexpert.com/) é a plataforma de suporte da Mandriva. Ela oferece
uma nova experiência baseada na confiança e no prazer de recompensar os outros por suas contribuições.

Nós também convidamos você a participar de várias listas de discussão (http://www.mandriva.com/
community/resources/newsgroups) onde a comunidade Mandriva Linux demonstra a sua vivacidade e sa-
bedoria.

Lembre-se também de conectar à nossa página de segurança (http://www.mandriva.com/security). Esta pá-
gina reúne todo o material relacionado a segurança sobre as distribuições Mandriva Linux. Você irá encontrar
avisos de erros e falhas de segurança, assim como procedimentos para a atualização do kernel, uma lista de
discussão e o Mandriva Online (https://online.mandriva.com/). Esta página é essencial para qualquer admi-
nistrador de servidores ou usuário preocupado com segurança.

1.2. Junte-se ao Clube!

A Mandriva oferece uma grande variedade de vantagens através do Mandriva Club (http://club.mandriva.
com):

• download de software comercial normalmente disponível apenas em pacotes no varejo, como drivers para
equipamentos especiais, aplicações comerciais, freeware e versões de demonstração;

• vote e sugira novos softwares através do nosso sistema de votação;

• acesse mais de 50,000 pacotes RPM para todas as distribuições Mandriva Linux

• ganhe descontos para produtos e serviços na Mandriva Store (http://store.mandriva.com);

• tenha acesso a uma lista de mirrors exclusiva para membros do clube;

• leia artigos e participe de fóruns em diversos idiomas.

• acesse a Base de Conhecimento (http://club.mandriva.com/xwiki/bin/view/KB/) da Mandriva, um web
site do tipo wiki que hospeda documentação sobre diversos assuntos, como administração, conectividade,
resolução de problemas e mais;

• converse com os desenvolvedores da Mandriva Linux no Club Chat (https://www.mandrivaclub.com/user.
php?op=clubchat);

• aumente os seus conhecimentos sobre GNU/Linux através das lições de treinamento à distância da Mandriva
(http://etraining.mandriva.com/).

Participando da Mandriva através do Mandriva Club você estará contribuindo diretamente para o aperfeiçoa-
mento da distribuição Mandriva Linux e nos ajudando a oferecer o melhor desktop GNU/Linux para os nossos
usuários.
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Uma nova versão do Mandriva Club está a caminho. Você pode
vê-la através da nova URL (http://club-beta.mandriva.com/).
Uma nova Base de Conhecimento (http://club-beta.mandriva.
com/xwiki/bin/view/KB/) também está sendo repensada.

1.3. Assinando o Mandriva Online

A Mandriva oferece uma maneira muito conveniente de manter o seu sistema automaticamente atualizado,
mantendo bugs afastados e corrigindo falhas de segurança. Visite o web site Mandriva Online (https://
online.mandriva.com//) para aprender mais sobre este serviço.

1.4. Comprando Produtos Mandriva

Os usuários do Mandriva Linux podem comprar produtos on-line através da Mandriva Store (http://store.
mandriva.com/). Você não irá apenas encontrar software Mandriva Linux, sistemas operacionais e CDs “live”
(como o Move), mas também ofertas especiais para assinantes, suporte, softwares e licenças de terceiros, docu-
mentação, livros relacionados a GNU/Linux e outros produtos da Mandriva.

1.5. Contribuindo com o Mandriva Linux

As habilidades de muitas pessoas talentosas que utilizam o Mandriva Linux podem ser muito importantes no
desenvolvimento do sistema Mandriva Linux:

• Empacotamento. Um sistema GNU/Linux é feito principalmente de programas recolhidos da internet. Eles
têm que ser empacotados para poderem funcionar juntos.

• Programação. Existem vários, vários projetos diretamente apoiados pela Mandriva: encontre o que mais lhe
agrada e ofereça a sua ajuda para o(s) desenvolvedor(es) principais.

• Internacionalização. Você pode nos ajudar a traduzir páginas web, programas e documentação.

Consulte a página dos projetos de desenvolvimento (http://qa.mandriva.com/) para saber como você pode
contribuir para a evolução da Mandriva Linux.

2. MCC’s Components

The Mandriva Linux Control Center (MCC) enables the system administrator to configure the hardware and the
services used by all users in a friendly way.

Access the Mandriva Linux Control Center through the main menu (System+Configuration→Configure
Your Computer).

Some of the Mandriva Linux Control Center components are al-
so available from the command line in text mode by running
drakconf.
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Figura 1. The Control Center’s Main Window

Here are some of the available menu entries:

• Options→Display Logs. When activated this option displays a Tools Logs window. It shows all system mo-
difications made by the configuration tools launched from within the Mandriva Linux Control Center.

• Options→Expert mode. Gives you access to some of the more advanced tools, which are marked in the
table below.

• Profiles. This menu gives you access to the configuration profiles features. We cover this topic in Seção 5.

• Help→Help. Opens the help browser which displays documentation about the active configuration tool.

• Help→Report Bug. Allows you to report a bug to the development team. See Seção 6.

The tools are sorted into categories. The following table lists them all and refers to the corresponding sections
of this manual.

Software Management Capítulo 1

Configuration Uploader: allows you to upload your configuration to the
Mandriva Online facility in order to benefit from available software
updates. Available only in Mandriva Linux Control Center’s expert mode.

Hardware Seção 3.1

Seção 3.2

Seção 3.3

Seção 3.4

Seção 3.5

Seção 3.6

Seção 3.7

Seção 3.8

Network & Internet Seção 4.1

DrakProxy: enables you to configure a proxy to access the Internet.

Seção 4.2

System Seção 5.1

3
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Display manager chooser: allows you to choose the X11 display manager
for users who graphically log onto the machine. Basically, all display
managers offer the same features, it’s just a question of taste.

Seção 5.2

Seção 5.3

Seção 5.4

Seção 5.5

Console: simply opens a terminal to directly enter commands with the
administrator account (root).

Seção 5.7

Seção 5.8

DrakAuth enables you to select the authentication mode to be used to
authenticate users on your system. Available only in Mandriva Linux
Control Center’s expert mode.

Mount Points Seção 6.1

Seção 6.2

Seção 6.4

Seção 6.3

Seção 6.6. This is an experimental utility to mount remote WebDAV
directories.

Seção 6.5

Security Seção 7.1. Available only in Mandriva Linux Control Center’s expert
mode.

Seção 7.2. Available only in Mandriva Linux Control Center’s expert
mode.

Seção 7.3

Boot Seção 8.1

Seção 8.2

Seção 8.3

Tabela 1. Overview of Graphical Tools

Additionally, the Online Administration category only appears if
the rfbdrake package is installed. This tool allows you to take
control of a remote host (Linux/UNIX®, Windows®).

Some more categories appear if the drakwizard package is
installed. The documentation for those wizards is available ondisk
as well as in the Guia do Servidor . Those wizards enable you to do
basic configuration of common LAN services such as web, FTP,
mail and database servers.

3. Nota do Editor

Na filosofia do código aberto, contribuidores são muito bem-vindos! Atualizar a doumentação do Mandriva
Linux é uma tarefa e tanto. Você pode ajudar de várias formas. Na verdade, a equipe de documentação está
procurando constantemente por voluntários talentosos para nos ajudar com as seguintes tarefas:

• elaboração ou atualização;

• tradução;

• edição;

4
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• programação XML/XSLT.

Se você tem bastante tempo, pode escrever ou atualizar um capítulo inteiro; se você fala outro idioma além do
inglês, pode nos ajudar a traduzir os nossos manuais; se você tem idéias de como melhorar o nosso conteúdo,
conte-nos; se você possui habilidade com programação e quer nos ajudar a aperfeiçar o Sistema de Criação
de Conteúdo Colaborativo Borges (C3S) (http://sourceforge.net/projects/borges-dms), junte-se a nós. E
não hesite em nos contactar se você encontrar qualquer erro na documentação, pois assim podemos corrigí-los!

Para qualquer informação sobre o projeto de documentação do Mandriva Linux, por favor entre em con-
tato com o administrador da documentação (mailto:documentation@mandriva.com) ou visite a pági-
na do Projeto de Documentação do Mandriva Linux (http://qa.mandriva.com/twiki/bin/view/Main/
DocumentationTask/).

Note que desde junho de 2004 a documentação do Mandriva Linux
e o desenvolvimento do Borges é feito pela empresa NeoDoc (http:
//www.neodoc.biz).

4. Convenções utilizadas neste livro

4.1. Convenções Tipográficas

Para realmente diferenciar as palavras especiais do fluxo do texto, a equipe de documentação utiliza diferentes
interpretações. A tabela a seguir demonstra um exemplo de cada palavra especial ou grupo de palavras com
a sua interpretação atual e o que cada uma significa.

Exemplo
Formatado

Significado

inode Utilizado para enfatizar um termo técnico.

ls -lta Utlizado para comandos e seus argumentos. (veja Seção 4.2.1).

um_arquivo Utilizado para nomes de arquivo. Também poed ser encontrado em nome de pacotes
RPM.

ls(1) Referência para uma man page. Para ler a página, simplesmente digite man 1 ls, na
linha de comando.

$ ls *.pid Formatação usada para representações textuais do que pode estar sendo exibido na
sua tela, incluindo interações com o computador, listagem de programas, e outros.

localhost Informações literais que não se encaixam em nenhuma das categorias definidas
anteriormente. Por exemplo, uma palavra-chave retirada de um arquivo de
configuração.

OpenOffice.org Define nomes de aplicação. Dependendo do contexto, o nome da aplicação e o do
comando podem ser o mesmo, mas formatados de maneira diferente. Por exemplo, a
maior parte dos comandos estão escritos com letras minúsculas, enquanto nomes de
aplicações normalmente começam com letra maiúscula.

Aquivos Indica entrada de menus ou rótulos da interface gráfica. A letra sublinhada, quando
presente, informa um atalho, que pode ser acessado pressionando a tecla Alt mais a
letra em questão.

Le petit chaperon
rouge

Identifica palavras em outros idiomas.

Aviso! Reservedo para avisos especiais, para dar ênfase à importância das palavras. Leia em
voz alta.

Este ı́cone destaca uma nota. Geralmente, é uma remarca no con-
texto atual, dando informação adicional.

5

http://sourceforge.net/projects/borges-dms
mailto:documentation@mandriva.com
http://qa.mandriva.com/twiki/bin/view/Main/DocumentationTask/
http://qa.mandriva.com/twiki/bin/view/Main/DocumentationTask/
http://www.neodoc.biz
http://www.neodoc.biz


Prefácio

Representa uma dica. Ele pode ser um conselho geral de como exe-
cutar uma ação espećıfica, ou uma bela funcionalidade que poderá
tornar a sua vida mais fácil, como teclas de atalho, por exemplo.

Tenha bastante cuidado ao ver este ı́cone. Ele sempre significa que
uma informação bastante importante sobre um tópico espećıfico
que precisa ser abordado.

4.2. Convenções Gerais

4.2.1. Sinopse dos Comandos

O exemplo abaixo demonstra os símbolos que você encontrará quando o autor descreve os argumentos de um
comando:

comando <argumento não literal> [--opção={arg1,arg2,arg3}] [argumento opcional ...]

Essas convenções são padronizadas e você poderá encontrá-las em outros lugares, como as páginas do manual.

Os símbolos “<” (menor que) e “>” (maior que) denotam um argumento mandatório a não ser copiado
verbatim, mas a ser substituído de acordo com as suas necessidades. Por exemplo, <nome_do_arquivo>
refeer ao nome de um arquivo. Se o nome é foo.txt você deve digitar foo.txt, e não <foo.txt> ou
<nome_do_arquivo>.

Os colchetes (“[ ]”) denotam argumentos opcionais, que podem ou não ser incluídos no comando.

As reticências (“...”) significam um número arbitrário de argumentos que podem ser incluídos.

As chaves (“{ }”) contém os argumentos autorizados neste lugar específico. Um deles deverá ser colocado aqui.

4.2.2. Anotações Especiais

De tempo em tempo você será direcionado a pressionar, por exemplo, as teclas Ctrl-R, o que significa que você
deve pressionar e manter pressionada a tecla Ctrl e então pressionar a tecla R em seguida. O mesmo caso se
aplica para as teclas Alt e Shift.

Nós utilizamos letras maiúsculas para representar as teclas, mas isto
não significa que você tem que digitá-las em maiúscula também.
Entretanto, pode haver programas em que R não significa o mesmo
que r. Você será informado quando estiver trabalhando com estes
programas.

Em relação aos menus, acessar o item Arquivo→Recarregar configuração do usuário (Ctrl-R) significa: clique
no texto Arquivo exibido no menu (normalmente localizado na diagonal superior esquerda da janela). Então,
quando o menu desdobrar, clique no item Reacrregar configuração do usuário. Além disto, você é informado
que pode utilizar a combinação de teclas Ctrl-R para obter o mesmo resultado.

4.2.3. Usuários Genéricos do Sistema

Sempre que possível nós utilizamos dois usuários genéricos em nossos exemplos:

Queen Pingusa queen Este é o nosso usuário padrão, utilizado na maior
parte dos exemplos neste livro.

Peter Pingus peter Este usuário pode ser criado mais tarde pelo
administrador do sistema e, às vezes, é utilizado
para variar durante o texto.

6
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5. Managing Configuration Profiles

A profile is a specific set of configuration settings suited for a computer in a given environment. Profiles allow
you to store configuration parameters specific to certain environments and to switch between them, according
to the context.

By default Mandriva Linux Control Center profiles enable you to configure network setups for different locations.
This is especially useful for laptops which need a different configuration for home, at the office, the coffee shop,
etc. It also allows you to activate different services from one profile to another (see Seção 5.2).

5.1. Profile Handling

New profiles you wish to create are based on the active one. All modifications are automatically recorded in
the active profile. A single menu (Profiles) lets you manage them.

Figura 2. The Control Center’s Profile Menu

New

Creates a new profile based on the active one’s settings. A dialog pops up asking for the name of the new
profile. Don’t forget to switch to that profile after creating it.

Delete

Shows a list of profiles you can remove. The active profile won’t be shown because it can’t be removed
while being used.

default

The entries which follow correspond to all available profiles, the active one being checked. Click on a
profile name to switch the host configuration to that profile.

Let’s take an example. You come back home with your brand new laptop which your system administrator
configured so you can connect to your corporate network. You now want to configure the network to access
the Internet from home with a dialup connection.

1. Create a new profile called “Home”.

2. Switch to it.

3. Reconfigure your network so that the modem, instead of the network card, is used to access the Internet
(see Seção 4.1).

4. Connect to the Internet.

5. When back at the office, switch back to the “default” profile.

5.2. Choosing a Profile at Boot Time

It’s more convenient to specify a profile at boot time than to activate it once the system is booted. drakboot
(Seção 8.2) allows you to associate a specific profile to each menu entry of the bootloader.

7
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Figura 3. Associating a Profile to a Boot Entry

Create or modify a boot entry in drakboot. In the Advanced options, access the Network profile pull-down menu
and select the profile you want to associate to it.

6. The Drakbug Reporting Tool

If you encounter unexpected behavior in Mandriva Linux-specific tools, Drakbug allows you to report it to the
development team.

To be able to report bugs using Drakbug, you need a working
Internet connection as well as a Drakbug account (http://qa.
mandriva.com/createaccount.cgi).

To run Drakbug, go to the Help→Report Bug menu entry of the faulty tool, or run it from Mandriva Linux Control
Center’s own menu. Drakbug can also be triggered automatically by a crashed Mandriva Linux tool.
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Figura 4. Reporting a Bug

In order to correctly report a bug, it is important to identify the package it is related to. To make this task easier,
enter the application name in the Application Name (or Full Path) field and click on the Find Package button.

Click on the Report button. Your web browser will then open. If you are not logged in to the Mandriva Bugzilla
web site (http://qa.mandriva.com/) you will be asked to log in (or create an account if you do not have one).
Once you are logged on the site, complete the bug report as completely and accurately as possible and click
on Commit

9

http://qa.mandriva.com/


Prefácio

10



Caṕıtulo 1. Gerenciamento de Pacotes através do Rpmdrake

Mandriva Linux usa o sistema de pacotes RPM e oferece ferramentas convenientes para simplificar a instalação
destes pacotes através da resolução atuomática de dependências. O conjunto de programas urpmi é baseado na
linha de comando e discutido rapidamente no Manual de Referência; aqui iremos nos concentrar no Rpmdrake:
a ferramenta gráfica de instalação de programas do Mandriva Linux.

Rpmdrake é constituído por diversas ferramentas que podem ser acessadas através de Sistema+Configuração+Pacotes
no menu principal ou então através do ícone Gerenciador de software no Mandriva Linux Control Center (veja Fi-
gura 1-1).

Figura 1-1. Gerenciador de Software no Centro de Controle Mandriva

Recomendamos que você acesse o Rpmdrake através do Mandriva Linux Control Center.

1.1. Instalando Programas

Ao iniciar esta ferramenta, será necessário aguardar alguns momentos enquanto Rpmdrake analisa
a base de dados de pacotes. Após esta análise, a interface Instalação de Pacotes de Software será
apresentada.

11



Capítulo 1. Gerenciamento de Pacotes através do Rpmdrake

Figura 1-2. A interface de Instalação de Pacotes de Software

A janela está dividida em quatro partes: a parte superior apresenta algumas possibilidades de manipulação da
lista de pacotes que podem ser instalados. Esta lista está no meio, à esquerda. Ao seu lado, à direita, temos uma
área onde pode ser vista uma descrição do pacote atualmente selecionado. Na parte inferior da janela existem
dois botões e informações sobre quanto espaço em disco será necessário para instalar os pacotes selecionados,
bem como quanto espaço livre existe atualmente.

Além disto, uma barra de estado na parte inferior da janela exibe
mensagens sobre as ações atualmente em progresso ou uma notifi-
cação sobre quando alguma tarefa foi terminada.

1.1.1. Selecionando Pacotes para Instalação

Vamos analisar a figura Figura 1-2 em mais detalhes. Um pacote chamado “frozen-bubble-1.0.0-7mdk” está
selecionado na visão em árvore e, na área que descreve o pacote, temos exibidas as informações de espaço em
disco necessário, um pequeno resumo (Frozen Bubble, jogo tipo arcade) e uma descrição mais detalhada (cheio
de recursos, pingüim colorido, animado e bonitinho...).

Se sua ḿıdia de instalação estiver configurada para utilizar a lista
completa de pacotes (ou seja, não o formato parcial synthesis,
mas sim o formato completo hdlist, que é o padrão da instalação
do sistema Mandriva Linux), informações adicionais sobre o pacote
podem ser obtidas através da opção Informação máxima na área de
acesso. Além disto, uma lista dos arquivos fornecidos pelo pacote e
seu registro de alterações também podem ser vistos.

A barra de estado informa o espaço em disco necessário para instalar os pacotes selecionados bem como
quanto espaço livre ainda existe no momento. Note que, devido às dependências, o espaço em disco necessário
pode ser maior que o espaço necessário para apenas o pacote selecionado.
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Capítulo 1. Gerenciamento de Pacotes através do Rpmdrake

O Rpmdrake emitirá um alerta caso não haja espaço em disco su-
ficiente para executar a instalação pedida. Você pode, no entanto,
continuar mesmo assim (você pode, por exemplo, remover arquivos
que não são mais necessários, como programas baixados da Internet
no passado e que não são mais usados, de forma que a instalação
possa continuar).

Agora a instalação pode ser iniciada, bastando para isto clicar no botão Instalar. Uma nova janela aparecerá
com uma barra de progresso mostrando o andamento da instalação. Para sair sem executar nada, basta clicar
no botão Cancelar.

Durante a seleção dos pacotes, pode acontecer que seja selecionado um pacote que requer dependências adi-
cionais para funcionar corretamente (como bibliotecas novas ou outra ferramenta). Neste caso, Rpmdrake mos-
trará uma janela onde as dependências adicionais poderão ser aceitas ou não. Para rejeitar as dependências,
clique no botão Cancelar (Figura 1-3).

Figura 1-3. Rpmdrake — janela de alerta de dependência

Outro cenário possível: você deseja instalar um pacote que requer dependências e vários outros pacotes são
capazes de prover as dependências necessárias. A lista de pacotes alternativos será então exibida (Figura 1-
4). Você pode analisar a informação adicional apresentada clicando no botão Informação... de forma a poder
escolher a melhor alternativa.

Figura 1-4. Rpmdrake — alternativas de pacotes

Vamos agora analisar em mais detalhes as funções de pesquisa e ordenação disponíveis para facilitar seu
trabalho de administração do sistema.
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1.1.2. Procurando Pacotes

Algumas vezes você pode conhecer uma ferramenta que viu em algum lugar ou sobre a qual ouviu falar na
casa de um amigo e agora fica imaginando como encontrar e instalar este programa.

É bastante fácil: apenas digite o nome (ou parte dele) na área de texto ao lado do botão Procurar. Agora escolha,
a partir da lista, onde você gostaria de realizar esta pesquisa (no nome do pacote, na sua descrição ou na lista
de arquivos pertencentes ao pacote). Após clicar no botão Procurar, uma nova lista aparecerá (Resultados da
busca), mostrando o que o Rpmdrake encontrou.

Vamos analisar as opções de ordenação:

Recomendação do Mandriva Linux

Esta opção de ordenação mostra a lista de pacotes nos quatro grupos que foram vistos durante a instalação
do Mandriva Linux. Esta é a opção de ordenação mais simples e fácil pois ela se concentra em apenas uma
parte específica dos pacotes disponíveis: aqueles que são considerados os mais úteis da distribuição.

Todos os pacotes, alfabeticamente

Ao invés de uma visão em árvore, esta opção mostra uma lista simples de todos os pacotes disponíveis
que podem ser instalados no seu sistema.

Todos os pacotes, por grupo

Aqui os pacotes são exibidos agrupados de acordo com sua função (por exemplo: Jogos, Sistema, Vídeo,
etc.).

Todos os pacotes, por tamanho

Nesta opção, a lista de pacotes está ordenada por tamanho (o maior pacote no topo e o menor no fim da
lista).

Todos os pacotes, por estado de seleção

Ao escolher esta ordenação, será apresentada uma lista simples onde os pacotes selecionados são apre-
sentados primeiro e os outros logo abaixo. Para tornar isto mais fácil, estas duas partes da lista estão
ordenadas alfabeticamente. Esta opção de ordenação é particularmente útil para ser usada momentos
antes de executar a instalação desejada, pois facilita a visão dos pacotes que serão instalados.

Todos os pacotes, por repositório de mídia

Mais uma vez os pacotes estarão ordenados alfabeticamente, mas desta vez eles são exibidos sob o nome
do repositório de mídia que os contém.

Todos os pacotes, por disponibilidade de atualização

Neste modo, dois grupos de pacotes podem surgir: um contém a lista de pacotes que podem ser acrescen-
tados ao seu sistema, e o outro contém a lista de pacotes que podem ser atualizados (ou seja, uma versão
antiga está atualmente instalada e existe uma nova disponível).

1.2. Removendo Programas

Como esta interface funciona de forma semelhante a “Instalando Programas”, não iremos repetir
suas funções básicas. A única diferença para a interface de instalação de programas é que você irá
lidar com pacotes que já estão instalados e escolher quais serão removidos em vez de que pacotes

serão instalados.
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1.3. Atualizador do Mandriva Linux

Mais uma vez: se você já trabalhou com a interface de instalação de programas do Rpmdrake, então
irá se sentir confortável com a interface do Atualizador do Mandriva Linux. Mas vamos analisar alguns
aspectos deste aplicativo mesmo assim.

Assim que esta ferramenta for iniciada, ela pedirá para que seja escolhido um repositório Internet que de-
verá ser analisado à procura de atualizações. Você deve escolher o que estiver mais próximo da sua região
geográfica.

Uma pequena diferença em relação à interface do programa de instalação de pacotes é a possibilidade de se
escolher que tipo de atualização se deseja instalar. Você pode selecionar:

Atualizações de segurança

Estas atualizações resolvem problemas de segurança e devem ser instaladas o quanto antes.

Atualizações para correção de erros

Estas atualizações corrigem problemas diversos nas aplicações.

Atualizações normais

São atualizações que trazem alguma pequena melhoria ou nova característica.

A outra diferença é uma nova seção de texto (chamada "motivo da atualização") existente dentro da área de
descrição do pacote. Ela oferece informações sobre o motivo desta atualização ter sido tornada disponível. Isto
pode ajudar na decisão de atualizar o pacote ou não. Se você tiver uma conexão Internet lenta, ou tiver que
pagar por MB durante o download, por exemplo, pode ser importante conhecer o motivo da atualização.

Se você ainda não estiver familiarizado com esta interface, por favor consulte Seção 1.1 para saber mais.

1.4. O Gerenciador de Ḿıdias de Programas

Esta parte do Rpmdrake é dedicada para a configuração dos repositórios de pacotes. Como pode
ser visto em Figura 1-5, existem algumas mídias já configuradas: “Main”, “Contrib”, etc. Com esta
ferramenta, você pode adicionar outras mídias de programas: um CD de uma revista contendo

RPMs, um repositório web, etc.
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Figura 1-5. O “Gerenciador de Mídias de Software”

As caixas de seleção nas colunas à esquerda permitem que você marque os repositórios:

Habilitar?

Desmarque esta opção para temporariamente desabilitar a mídia correspondente. Os pacotes contidos
nesta mídia não estarão disponíveis para instalação até que ela seja habilitada novamente.

Atualizações?

Esta caixa de seleção deverá estar marcada para mídias de atualizações, ou seja, mídias que contenham
atualizações de pacotes que já estão em alguma outra mídia, mas com versão mais antiga. Desta forma
apenas mídias marcadas desta forma são analisadas durante uma atualização.

Botões diversos que permitem executar alguma ação na mídia selecionada.

Remover

Permite que uma mídia que não está mais em uso seja removida. Basta selecionar a mídia a ser removida
e clicar neste botão.

Editar

Aqui você pode modificar a URL ou o diretório relativo do arquivo synthesis/hdlist (se você não
estiver entendendo este assunto é recomendado que saia da janela através do botão Cancelar em vez de
Salvar alterações).

Caso você precise utilizar um proxy para acessar alguma mídia, ele pode ser configurado através do botão
Proxy.... Note que você também pode definir uma variável global de proxy para todas as mídias remotas
através do botão Proxy... da interface principal.

Esta opção também permite que se mude o formato do repositório de hdlist para synthesis, que é
bem menor mas contém menos informações sobre os pacotes. Arquivos synthesis somente possuem in-
formações sobre o nome dos pacotes, suas dependências e um pequeno resumo. Não será possível, por
exemplo, realizar pesquisas sobre os arquivos contidos em pacotes não instalados e a descrição completa
também não estará disponível.
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Adicionar...

Use este botão para adicionar ao seu sistema todas as fontes de pacotes publicamente disponíveis em
repositórios da Internet. Isto é útil, por exemplo, caso você tenha uma conexão rápida ou somente possui
o primeiro CD de instalação disponível. Escolha um servidor geograficamente perto da sua localização.

Figura 1-6. Rpmdrake — acrescentando uma nova fonte

Após escolher um servidor e clicar no botão Ok, informações sobre os pacotes disponíveis nesta fonte
serão baixadas e todos os pacotes estarão disponíveis para instalação e atualização.

Adicionar personalizado...

Este botão abre uma janela de diálogo onde uma nova mídia de instalação de pacotes de software pode
ser acrescentada.

Figura 1-7. Rpmdrake — acrescentando mídias
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Atualizar...

Ao clicar neste botão, uma lista das mídias já definidas será apresentada. Você pode escolher aquelas cuja
lista de pacotes você deseja atualizar. Isto é útil para mídias remotas que receberam novos pacotes na sua
base. Depois de fazer esta seleção basta clicar em Atualizar para iniciar o processo.

Gerenciar chaves...

É muito importante que quaisquer pacotes que forem instalados sejam autenticados. Cada pacote pode
ser assinado digitalmente com uma “chave”, e você pode permitir ou proibir certas chaves de forma
individual por mídia. Em Figura 1-8, você pode ver que a chave da Mandriva Linux está autorizada para
a mídia “CD de Instalação”. Clique em Adicionar chave... para autorizar uma outra chave para a mídia
selecionada (atenção: faça isto com cuidado, como em todas as questões de segurança). Para remover
uma chave associada com uma mídia, clique em Remover chave.

Figura 1-8. Rpmdrake — gerenciando chaves

Proxy...

Se você estiver atrás de um firewall e precisar ter acesso a mídias remotas (para atualizações, por exem-
plo), você pode fazê-lo se tiver um servidor proxy que permite o acesso à Internet (pelo menos à região
onde houver um servidor de atualizações). Normalmente é suficiente preencher o campo Servidor proxy
para ter isto funcionando (Figura 1-9). Se você precisar de uma combinação de usuário / senha, isto
também pode ser especificado aqui. As alterações podem ser confirmadas através do botão OK.
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Figura 1-9. Rpmdrake — configurando um proxy

Paralelo...

Se você estiver administrando uma grande rede de computadores, pode querer instalar os pacotes em
todos eles em paralelo; este botão abre uma janela de diálogo que permite a configuração do modo “para-
lelo”. Como este modo é relativamente complicado e somente é útil para um grupo limitado de pessoas,
esta curta introdução não irá fornecer mais detalhes.

Opções globais...

Este botão permite que se escolha o programa utilizado para baixar os pacotes e se a fonte deve ser
verificada com uma chave ou não. Estas opções afetam todas as fontes configuradas.

Setas para cima e para baixo

Estes botões permitem que a ordem de utilização das fontes seja alterada.
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Para usuários avançados
O Rpmdrake processa o arquivo de configuração do urpmi
(/etc/urpmi/urpmi.cfg) do ińıcio até o fim para obter a lista de
repositórios e pacotes contidos em cada um.

Caso um repositório posterior contenha pacotes que também
existem em um repositório anterior (isto é, mais próximo do
topo do arquivo), apenas aparecerão os pacotes do repositório
posterior. Se o repositório posterior tiver todos os pacotes de
algum repositório anterior, este repositório anterior nem será
exibido.

Desta forma, se seu arquivo urpmi.cfg tiver por exemplo
cinco repositórios definidos, é posśıvel que Rpmdrake exiba apenas
o último se ele tiver todos os pacotes já contidos nos quatro
repositórios anteriores. Alterar a ordem de definição das ḿıdias no
arquivo urpmi.cfg pode causar uma exibição de ḿıdias mostradas
pelo programa Rpmdrake bem diferente mesmo estando os mesmos
pacotes dispońıveis.

De qualquer forma, os pacotes não deixarão de estar dis-
pońıveis, é apenas a lista de repositórios que será diferente.

O Rpmdrake processa o arquivo de configuração do urpmi
(/etc/urpmi/urpmi.cfg) do ińıcio até o fim para obter a lista de
repositórios e pacotes contidos em cada um.

Caso um repositório posterior contenha pacotes que também
existem em um repositório anterior (isto é, mais próximo do
topo do arquivo), apenas aparecerão os pacotes do repositório
posterior. Se o repositório posterior tiver todos os pacotes de
algum repositório anterior, este repositório anterior nem será
exibido.

Desta forma, se seu arquivo urpmi.cfg tiver por exemplo
cinco repositórios definidos, é posśıvel que Rpmdrake exiba apenas
o último se ele tiver todos os pacotes já contidos nos quatro
repositórios anteriores. Alterar a ordem de definição das ḿıdias no
arquivo urpmi.cfg pode causar uma exibição de ḿıdias mostradas
pelo programa Rpmdrake bem diferente mesmo estando os mesmos
pacotes dispońıveis.

De qualquer forma, os pacotes não deixarão de estar dispońıveis, é
apenas a lista de repositórios que será diferente.
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Being able to remotely control another machine offers many possibilities, from remote technical assistance to
teaching how an application works. In this chapter we describe the configuration and usage of Rfbdrake, a tool
to easily set up a virtual network computing environment under Mandriva Linux.

2.1. Concepts

Here are a few concepts:

Virtual Network Computing (VNC)

An environment which allows you to interact with a remote computer “as if you were sitting in front of
that computer”. The computers don’t have to be of the same type, nor do they have to be running the
same OS: they only need a working TCP/IP network connection.

Controlled Computer

This is the computer to be controlled without the need, or the possibility, to be actually sitting at its
console. It is remote from your location. Also called the “server”.

Controlling Computer

This is the computer in front of which you’re sitting, from where you interact with the controlled (remote)
computer. Also called the “viewer”.

2.2. Installation and Setup

Make sure the rfbdrake package is installed and then access Rfbdrake through the Mandriva Linux
Control Center: an Online Administration section is accessible from which you can start the Remote
Control of another machine (Linux/Unix, Windows) utility1.

2.2.1. Controlled Computer Setup

In this section, we assume you can access Rfbdrake. If this is not the case (typically remote administration
tasks), then you need to:

1. Make sure the tightvnc-server package is installed on the remote machine.

2. Connect to the remote machine using ssh.

3. If it’s not already running, start the VNC server by executing vncserver in a console. If this is the first
time vncserver is run on teh system with that user account, then you have to enter the password clients
will have to use to connect and confirm it. The system informs you which display number clients have to
use. Run vncserver -kill :DISPLAY_NUMBER when you no longer need the VNC server.

Then connect as a client to control the remote machine (see Seção 2.2.2).

For the machine that will act as the controlled (server) computer, select the Allow control of my machine (linux
server) option. Fill the Set Password field. This is mandatory or Rfbdrake will complain. Please bear in mind that
this password is not related to the user’s local/remote account password in any way.

1. You can also launch Rfbdrake by choosing Internet+Remote access→Virtual Network Connection in the main menu.
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Figura 2-1. Server Options

Once you click on the Launch server this icon indicates that the computer is ready to accept incoming
VNC connections. Closing it will stop the VNC server. Right-click on it to access a pop-up menu with some
options.

If the system to be controlled is behind a firewall, then you have to
make sure that port tcp/5900+N is opened in the firewall, where
N is the VNC server display number.

2.2.2. Controlling Computer Setup

On the machine which will act as the controller (viewer) computer, select the Want to take control (linux client)
option. Fill the Remote server Address pull-down list with the IP address or hostname of the computer to be
controlled. Fill the Display Number field with the remote computer’s display number, or leave it empty to use
the default (display number :0).
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Figura 2-2. Viewer Options

To access the VNC server, enter its related password in the Enter Password field. Put a mark in the FullScreen
check-box to have the remote computer’s desktop use all of the controller computer’s screen. Otherwise the re-
mote desktop will be displayed in a window. Once you are satisfied with your settings, click on the Connection
button to access the remote computer.
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2.3. Connecting to a Windows® Terminal Server

Figura 2-3. Windows Terminal Services Options

Select the Windows Terminal Services option to connect to Terminal Services on a Windows® machine. Fill the
Windows Hostname pull-down list with the hostname of the Windows® machine or its IP address. Select a
desktop size in the Screen Size pull-down list and a language for the keyboard in the Keyboard Language pull-
down list. Click on the Connection button once you’re satisfied with your settings.

2.4. Remote Control in Action

Once you connect to the remote computer you see its desktop and you are able to perform any action as if you
were sitting in front of it.
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Figura 2-4. Controlling a Remote Computer

The mouse cursor becomes a round point and the remote com-
puter’s arrow-cursor will “follow” it. This can prove useful to keep
track of where the cursor is at any given time.

The limiting factor of the response time of the remote computer is the speed of the link to it. For LAN con-
nections (typically 100 Mbps), you will feel that you’re really in front of the remote computer. For Internet
connections (typically between 56 Kbps and 1-2 Mbps), don’t expect “instantaneous” response from the con-
trolled computer.

Once you’ve finished using the remote computer, you can disconnect from it by closing the VNC viewer
window. If you’re using the full-screen mode, press the F8 key and select the Quit viewer option from the menu
which pops up.

2.5. More Documentation

This short introduction to VNC has hopefully shown you some of the possibilities of remotely controlling
computers. The options are endless, please refer to the TightVNC Documentation (http://www.tightvnc.
com/docs.html) and to the VNC Documentation (http://www.realvnc.com/documentation.html) web sites.
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3.1. Configuring your Hardware

3.1.1. Hardware Detection and Configuration

The HardDrake project has been developed to simplify hardware detection and configuration
under GNU/Linux by providing a user-friendly interface.

3.1.1.1. What Is HardDrake?

HardDrake is a service for hardware detection, run at system boot time, and also a full GUI-based tool which
ties together many of the tools already included in a GNU/Linux distribution. It automates and simplifies the
process of installing new hardware. For the most part, HardDrake will be able to detect most devices.

On one hand, HardDrake is used to display information, and on the other, it can launch configuration tools.
With its easy-to-use interface, you can browse all the hardware your system contains.

HardDrake uses the “ldetect” engine, so if your new hardware is not detected, you may try to upgrade the
ldetect library itself and its hardware database, located in the ldetect-lst package.

3.1.1.2. Usage

To launch HardDrake, you can start it through:

• the Mandriva Linux Control Center: click on the Hardware category, and then on the Hardware icon.

• a terminal: type harddrake2 as root. You can also pass parameters to HardDrake through the command
line (type harddrake2 -h to get a list of possible parameters).

• the desktop: go to the main menu. The HardDrake entry is in the System+Configuration+Hardware→HardDrake
sub-menu.

After all devices have been detected, the main HardDrake window will appear (see Figura 3-1).

On the left, you can see the device tree showing you all of the hardware categories.
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Figura 3-1. Selected Device

By selecting a device, you will see additional information about it in the right frame. To better understand
the meaning of the information presented, you can consult the help page accessible by choosing Help→Fields
description from the menu.

Depending on the device selected, two other buttons may appear:

• Configure module. This pops up a window with all the module device parameters listed. For experts only!

• Run config tool. Launches the Mandriva Linux configuration tool (available through the Mandriva Linux
Control Center) associated with that device.

A special category called Unknown/Others might also show up, containing all the currently unknown hard-
ware in your system, as well as known hardware that does not fit into the existing categories (such as thermal
sensors, random number generators, etc.).

You can also toggle the entries in the Options menu to enable automatic detection of some hardware which
wouldn’t have been detected otherwise. You need to restart HardDrake for those changes to have effect.

If you have a Mandriva Online account and want to help us improve hardware support under Mandriva Linux,
or want to see your hardware better supported in the future, you can choose File→Upload the hardware list
from the menu and fill the form with your account data, then click on the Ok button: your hardware list will
be uploaded. You need a working Internet connection.

3.1.2. Problems/Troubleshooting

If you think you have found a bug related to HardDrake, report it using the Mandriva Linux bug reporting tool
(see Seção 6).

HardDrake does not probe for ISA PnP devices. If you have an ISA PnP sound card, run sndconfig or
alsaconf from the command line. You may need to install the sndconfig package or the alsa-utils packa-
ge.

3.2. Controlling the Graphical Configuration

This set of tools allows you to configure your graphical display. With it you will be able to change your
video card, your resolution and your monitor. It can be useful if you happen to change one of your graphical
components after the initial installation.
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If you cannot boot into graphical mode and you end up in a console
(command-line interface), log in as root and launch XFdrake.
You will get a tool similar to the one described in Seção 3.2.3, but
in text mode.

The graphical configuration tools are accessible through different icons in the Mandriva Linux Control Center
Hardware section.

3.2.1. Changing the Monitor

Figura 3-2. Choosing a New Monitor

This tool allows you to change the monitor type currently in use. When you click on it a window
pops up, listing many monitor models (see Figura 3-2). If your monitor was automatically detected
it will be listed as Plug’n Play along with its model.

If your monitor wasn’t automatically detected, you can choose it from the list. If you don’t find your monitor
or a compatible one, choose one with parameters corresponding to your own monitor from the Generic entry,
at the bottom.
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3.2.2. Changing Resolution

Figura 3-3. Changing the Resolution of your Screen

This tool enables you to change the current screen resolution (800x600, 1024x768, etc.) and the
color depth. Simply choose the one you wish to use. The monitor in the window displays what
the desktop will look like with the chosen configuration (see Figura 3-3). If it looks good, click on
OK.

The changes will be activated after you quit and restart your graphical environment.

By default, the available resolution list only shows resolutions supported by your video card and monitor
combination. There is a special entry named Other which adds more possible resolutions along with their
ratio. Bear in mind that most monitors are designed with a 4:3 horizontal vs. vertical ratio.
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3.2.3. Controlling All Video Parameters

Figura 3-4. XFdrake Main Window

If you happen to change your video card after installing your system, or want to have full control over the
graphic configuration, run as root, XFdrake from a console. The tool shown in Figura 3-4 will be shown.

Let’s look at the interface. The first three buttons allow you to change certain aspects of the graphical configu-
ration:

Graphic Card

The button displays the name of the graphic card currently configured. If you wish to change it, just click
on it. Depending on your card, different servers may be available, with or without 3D acceleration. You
may need to try different ones until you get the best result.

In case you cannot find the graphic card you have, but you know which driver supports it, select it from
the Xorg entry at the bottom.

Monitor

Enables you to change the monitor with the tool described in Seção 3.2.1.

Resolution

Enables you to change the pixel resolution and the color depth with the tool described in Seção 3.2.2.

Then, there are more buttons:

• Test. Click on this button to verify that your modifications actually work. It is highly recommended you do
test it, because if it does not work, it will be harder later to recover a working graphical environment. If the
test fails simply wait until it ends. If you are not satisfied with the suggested settings, choose No during the
test, and you will be returned to XFdrake’s main menu.
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Depending on your video card, video testing may not be available.
You will be warned of such a situation. If it happens that the settings
are incorrect and your display does not work, refer to the Resolvendo
Problemas section of the Guia do Usuário manual to use XFdrake’s
text version.

• Options. You can choose to start the graphical server when your system boots. Answer No if you prefer to
have a text login. Selecting Yes will launch the graphical login manager at boot time.

• Quit. If you modified your graphical display in some way, the current configuration will be displayed and
XFdrake will ask you whether you want to keep your changes or not. This is your last chance to go back to
the old configuration. If all seems OK, click on Yes. If you wish to restore the previous parameters, click on
No.

The changes will be activated after you confirm them and restart your graphical environment.

3.3. Setting up a TV Card with DrakxTV

This tool will configure your TV tuner card in order for you to watch television on your computer
display.

First of all you should make sure your card is supported by Mandriva Linux by consulting the Hardware
Compatibility page (http://www.mandriva.com/hardware) or the BTTV driver home page (http://linux.
bytesex.org/v4l2/bttv.html/).

Modern TV viewing programs have their own configuration and
channel-scanning interface embedded. You only need to run
DrakxTV if you plan to use xawtv with old TV cards based on
the btxxx or saa71xx chips.

Make sure your card is correctly connected to your antenna or cable,
so that channel scanning runs properly.
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Figura 3-5. Choosing the TV Card Model

When you first launch the tool, and if a TV card is detected, the main configuration dialog (Figura 3-5) will
appear. Leave the default Auto-detect entries and press OK. If you notice afterward that your card was not
properly configured, you can run DrakxTV again and select the proper card.

Figura 3-6. Choosing the TV Norm and Country

You simply need to inform DrakxTV about the norm used for the television signal you receive, and the country
you’re in. You also have to select the user who is going to use xawtv so that his configuration file is created.

After you press OK, DrakxTV will begin automatic channel scanning. Once this is done, your TV setup will be
complete and you will be able to watch television on your computer using xawtv. Other applications allowing
to you watch TV under Mandriva Linux are kdetv, tvtime and zapping.
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3.4. Changing your Keyboard Layout

This tool allows you to define another keyboard layout. This is commonly done when the
keyboard you want to use is different from the one chosen at installation time.

Figura 3-7. Choosing a Different Keyboard Layout

Select your keyboard’s language and then its model from the lists shown in Figura 3-7. If you own a multi-
media keyboard and are lucky enough to have it listed in the manufacturer list, chances are most multimedia
keys on it will be supported. Otherwise, choose your keyboard type under the Generic branch. Changes are
effective immediately after clicking OK.

If you choose a keyboard layout based on a non-Latin alphabet,
the next dialog will ask you to choose the key binding that will
switch the keyboard configuration between the Latin and non-Latin
layouts.

3.5. Changing your Mouse

This tool enables you to set up a different mouse, which is useful if the mouse you are currently
using is not the same as the one you chose at installation time.

Synaptics Touchpad function is automatically configured to work
with almost every touch pad found on notebook computers. The
same goes for Wacom® tablets.
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Figura 3-8. Choosing a Different Mouse

Mice are sorted into a tree according to their connection type and model (see Figura 3-8). Highlight the mouse
of your choice and click OK. Changes take effect immediately after the mouse test is done.

The Any PS/2 & USB mice option works with virtually all modern
mice.

3.6. Configuring Printers with PrinterDrake

This tool allows you to:

• configure a newly installed printer on your machine;

• configure your machine to act as a server for a printer which has just been connected to your local network;

• set up your machine to access network printers served by other servers (GNU/Linux as well as Windows®

ones).

If you just installed a printer that wasn’t available when you installed
Mandriva Linux, make sure it is correctly connected and powered
on before launching the configuration tool.

3.6.1. Initial Configuration

When you first launch the PrinterDrake tool, it may be in one of these states:
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3.6.1.1. There is no printer directly connected to the computer.

Figura 3-9. Activate Printing

The tool did not detect any local printers. However you can print on network printers, or manually install
printers which weren’t detected by clicking on Yes.

Figura 3-10. Activating Network Printers

• Select the Local CUPS printing system option if you wish to configure your machine to act as a print server
for either a local printer which was not detected, or a network printer connected to your local network.

Any required software will be installed and then the main configuration interface (see Figura 3-11) appears.
Click on Add Printer to install the network printer.

• Select the Remote server option if you wish to be able to print on printers served by another CUPS printing
server on the network. Your applications will immediately have access to all public printers served by that
server. You only need to provide the hostname or IP address of that server in the field below (ask your
system administrator).

When this is done, the main configuration interface (see Figura 3-11) appears. The Configured on other machi-
nes tab will be filled with the available network printers.
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3.6.1.2. New Printer Detected

The following window appears when PrinterDrake detects a new printer.

Simply confirm the automatic installation of the new printer. The main configuration interface (see Figura
3-11) is then displayed. Make sure to check that the printer parameters fit your needs (see Seção 3.6.5).

3.6.1.3. Printer Configured at System Installation Time

The main configuration interface (see Figura 3-11) is shown. Make sure to check that the printer parameters fit
your needs (see Seção 3.6.5).

3.6.2. The Printer Management Interface

Use the printer configuration tool’s first tab for locally connected printers (Configured on this machine), and the
other tab for printers available on your local network (Configured on other machines).

If your local printer was automatically added you should now verify
its configuration. Select it in the list, click on Edit and check the
Printer options.

Figura 3-11. Managing Printers

The following buttons give you access to all available maintenance tasks:

• Add Printer: launches the printer configuration wizard described in Seção 3.6.4.

• Set as default: sets the selected printer as the default printer when no specific printer is chosen at print time.
A cross appears in the Def. column of that printer.

• Edit: opens the printer configuration dialog described in Seção 3.6.5.

• Delete: removes the selected printer from the available printer pool.
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• Refresh: updates the list of printers with possible new or removed printers, especially true for networked
printers.

• Configure CUPS: by default, your system is totally open. PrinterDrake uses all of the network’s available
printers and shares all of its local printers with the local network. Click on this button if you don’t want to
access network printers, or if you want to restrict the access to your local printers. This dialog also lets you
configure access to servers outside the local network.

The Options→Expert mode menu adds extra features to the tool.
See Seção 3.6.6.

3.6.3. Print Server General Configuration

The Configure CUPS button allows you to control the behavior of printers connected to your machine and to
your network.

Figura 3-12. CUPS Printer Server Configuration

This dialog enables you to switch between the client and server printing modes through the Remote CUPS
server and no local CUPS daemon button.
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3.6.3.1. Client Mode

Figura 3-13. Client Mode Configuration

Select the On option to connect to another printer server. You then just need to specify the name or IP address
of that server in the field below.

If you choose this mode, your printing configuration is now finished. Accept the options by clicking the OK
buttons, and you will be able to check the list of available printers in the Configured on other machines tab of
the main interface (see Figura 3-11).

3.6.3.2. Server Mode

If you want your machine to access locally connected printers (through parallel or USB ports), or network
printers not already configured on another server, you need to select the Off option. Click OK, and you will
then be able to fine tune your printer server (see Figura 3-12).

A number of options are available to further secure and enhance your print server features:

The printers on this machine are available to other computers

Allows other computers to print on printers configured locally. Remember to restrict access by clicking
on Printer sharing on hosts/networks (see below).

Automatically find available printers on remote machines

Tells your print server to automatically make available all printers found on other servers on the local
network, as if they were locally connected to your print server. This way your system’s users are able to
print on any printer the print server “sees”. If the remote printers you intend to use are served by a server
not on your local network, you can still tell the print server to use them with the Additional CUPS servers
button (see below).

Printer sharing on hosts/networks

Allows you to specify from which networks the local printers are made available.
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Additional CUPS servers

Allows you to specify one or more CUPS servers to which you can connect and access printers. Specify
the IP address and port of the CUPS server in the dialog.

Japanese text printing mode

Replaces the original text filter for one more suited to Japanese texts, but with less features. Use it if you
have to print Japanese text-only files.

3.6.4. The Printer Configuration Wizard

Click on Add printer and the configuration wizard comes up.

3.6.4.1. Detecting a Printer

This tools enables the auto-detection of locally connected printers, network printers, and finally printers ser-
ved by SMB (Windows®) servers. First choose which type of printer you want to add (Local printer, Network
printer, Printer on remote lpd server, etc.).

Figura 3-14. Printer Type

Select the printer you want to add from the list. If the detected printer isn’t the correct one check the Manual
configuration box and proceed with the printer model step (see Figura 3-16). If autodetection fails, remove the
check mark from all check boxes, click on Next and follow the instructions below.

If you own a multi-function device like those of HP or Sony, an information window pops up and gives you
information about your scanner and scanner software (Seção 3.7.1.1). Additional packages are also installed.

PrinterDrake displays your printer’s model name. Choose Select model manually if it’s incorrect. Select the
printer you have or a compatible one (see Figura 3-15) if yours is not specifically listed.
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Figura 3-15. Choosing the Printer Model

If you want to install the driver supplied by your printer manufacturer, click on the Install a manufacturer-
supplied PPD file button and select the medium containing the PPD file and browse to it. Accept subsequent
dialogs to use your chosen PPD file.

Figura 3-16. Choosing a Name for your Printer

Provide a name for your printer. The printer name must contain only letters, numbers and the underscore
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(“_”) character. It’s better to limit its length to 12 characters maximum so that Windows® clients don’t have
problems when accessing it through Samba.

If you have one or more configured printers, you are asked whether
the printer you are configuring is to be the default printer. If you
say No, the previous default printer will be retained.

Finally we strongly recommend that you print a test page in order to make sure everythin works as expected.

3.6.4.2. Printing Options

Once the configuration is done, the options associated with the chosen printer are shown (see Figura 3-17).
It’s important you choose the proper settings (such as paper size, media source, etc.) currently installed on the
printer. If the settings you choose are incorrect, printing may fail.

Figura 3-17. Configuring the Printer’s Options

For settings referring to printout quality, bear in mind that higher
quality levels may make the printing operation slower and may con-
sume more ink.

3.6.4.3. Printer Test

A few test pages are available (see Figura 3-18). We recommend you print at least one test page so you can
immediately correct the parameters if something goes wrong. The printer should begin to print almost imme-
diately.
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Figura 3-18. Testing the Printer

3.6.4.4. It’s Done

If you’re not satisfied with your test page, answer the appropriate question with No and you will be led to the
printer configuration menu (see Figura 3-19) where you can correct the settings. See Seção 3.6.5.

Your printer will now appear in the list of available printers in the main window (see Figura 3-11).

3.6.5. Reconfiguring an Existing Printer

Double-clicking on a printer’s name in the list, or clicking on the Edit button, displays a menu where you can
choose actions to take on the selected printer (Figura 3-19). Each option gives access to a particular step of the
wizard we described above (see Seção 3.6.4). One difference is that the current settings are predefined in all
fields, and you may update them where required.
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Figura 3-19. Modifying an Existing Printer

There are a few additional options:

1. Disable Printer. Use this option to remove that printer from the printers available to the system’s users.
You might need to temporarily disable a printer under maintenance so that users don’t try to use it in the
meantime. When a printer is disabled, that option changes to Enable printer.

2. Learn how to use this printer. Displays information on how to use a particular printer model. In the case
of a multi-function device from HP, information about scanning and photo memory card access is also
displayed.

3. Remove printer. Deletes that printer’s configuration from the system.

Select an action in the dialog and then click on the Do it! button to perform it.

3.6.6. Expert Mode

The expert mode has three additional features:

• Choose a Different Driver to the Default One for a Printer. Different drivers are available for the same
printer. In expert mode, a third level appears in the printer model selection list (see Figura 3-15). It allows
you to change each printer’s driver.

• Install Many Kinds of Remote Printers. This feature enables you to print on remote printers using the LPD
protocol, printers on Windows® servers which require authorization, or other arbitrary printer types.

If PrinterDrake is in expert mode, it doesn’t automatically confi-
gure new local printers on start-up. Use the Add printer button to
configure the printer. However you can choose to Configure Auto
Administration from the Options menu to override that behavior.

If you start the new printer wizard in expert mode, there is an additional step at the beginning.
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Figura 3-20. Configuring a Remote Printer

Different connection types are available:

• Local printer. A printer directly connected to a parallel or USB port on your computer. In most cases, the
printer model will be auto-detected.

• Printer on remote lpd server. A printer already served by another machine on a lpd server.

• Network printer (TCP/socket). A printer directly connected to your local network. The network can be scan-
ned and printer models automatically detected provided the Printer auto-detection box is checked.

• Printer on SMB/Windows 95/98/NT server. Relevant for printers already connected to a computer running
an OS which serves printers with the SMB protocol, including Samba printers (the necessary Samba compo-
nents will be automatically installed in this case). The network can be scanned provided the Printer auto-
detection box is checked.

• Enter a printer device URI. This option allows you to directly enter the printer’s Universal Resource Identifier
(URI) on your network. It can be used for any of the above remote connections, and more. This is useful
when your system administrator provides you directly with the printer’s URI.

Click on the Modify timeout for network printer auto-detection button to change the default timeout (4000 milli-
seconds, or 4 seconds) for detection of networked printers. Please bear in mind that the bigger the timeout, the
better the chances of detecting remote printers. However the auto-detection process will also take more time.

3.7. Installing and Using Scanners

This section explains how to install a scanner through ScannerDrake, and how to use it with SANE and XSane
(scanner interface software). We also present a list of other scanner interface software you could use with
GNU/Linux.

Please note that not all scanners are supported under GNU/Linux.
Before buying new hardware, remember to check out Mandriva’s
Hardware Database (http://www.mandriva.com/hardware) and
the SANE home page (http://www.sane-project.org/) for com-
patibility issues.
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3.7.1. Configuring your Scanner

3.7.1.1. ScannerDrake

The ScannerDrake wizard helps you install your scanner. Make sure your scanner is powered on and
launch ScannerDrake by clicking on the Scanners entry of the Mandriva Linux Control Center’s Hardware section.

The program tries to detect your scanner’s manufacturer and model. If it finds one information about it is
displayed in the upper part of the wizard’s main window. Other options are also available (Figura 3-21):

Figura 3-21. Installing your Scanner

Click on Search for new scanners to autodetect a new scanner you just plugged in. Click on Add a scanner
manually if the automatic detection fails and look for the specific model you own by browsing through the list
of available models.

Figura 3-22. The Tree-list of All Known Scanner Models

After choosing the appropriate model, you can leave the default Auto-detect available ports option and click on
OK. If you have a parallel port scanner, selecting /dev/parport0 in the pull-down list should be the right
choice.
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Your scanner should now be installed and you should be ready to use the programs which come with SANE,
XSane or other acquisition software.

Note that HP multi-function devices, such as the OfficeJet and PSC
printers, must be configured through PrinterDrake. Please refer to
Seção 3.6. The scanning part of non-HP multi-function devices can
be set up with ScannerDrake as a stand-alone scanner.

To test that everything works correctly, launch xscanimage1 from a terminal and try to acquire a picture from
your scanner. You may first acquire a preview of the scanned image by clicking on the Preview window button,
as shown in Figura 3-23.

Figura 3-23. Acquiring Images with xscanimage

Note that xscanimage can also be launched directly from GIMP by choosing File+Acquire+xscanimage→Device
dialog.

ScannerDrake allows for scanner sharing between users connected via a LAN. Installation is very easy: just
click on Scanner sharing and either select The scanners on this machine are available to other computers or Use
scanners on remote computers depending on what you want to do. With these buttons you can define which
machines are allowed to use your scanners and which remote scanners you want to use.

1. The sane-frontends package must be installed.
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Figura 3-24. Sharing Scanners within a LAN

In order to share your scanner on your LAN, the saned package
needs to be installed. If it isn’t, ScannerDrake will ask you if you
want to install it. You also need to set up scanner sharing on the
machines from which you want to access the scanner. Check the
Use scanners on remote computers box, and then click on Add host.
Fill in the information in the Name/IP address of host field for each
of the machines which scanners.

3.7.2. Using Image Acquisition Software

3.7.2.1. XSane

While xscanimage is more than enough for your basic scanning needs, more experienced and/or graphic-
oriented users will want to use a more sophisticated program. XSane2 offers more options and a more infor-
mative display during the image acquisition process.

You can launch XSane through the Multimedia+Graphics→XSane menu item. Several windows pop up on your
screen.

2. The xsane package must be installed.
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Figura 3-25. XSane Multiple Windows

If the xsane-gimp package is installed, a GIMP plugin will be at
your disposal. It allows you to import your images directly into
GIMP for image retouching tasks. Choose File+Acquire →XSane:
device dialog to launch XSane. You can now scan your image and
have it sent directly to GIMP.

3.7.3. Advanced Configuration

3.7.3.1. Fine-Tuning the Resolution

Most modern scanners boast high resolutions, such as 1200, 1600 or 2400 DPI (Dots Per Inch). But it would be
a mistake to perform all of your scanning at the maximum available resolution. You will notice very little —
if any — quality difference between a 300 and a 600 DPI image scan, but the file size will grow exponentially,
up to many MBs of disk space for a single image file.

The resolution value should be chosen according to the device on which the image is to be reproduced. For
images to be viewed on computer monitors, e.g. for web sites, the resolution should be close to typical mo-
nitor resolution values, between 70 and 100 DPI. Higher values will result not only in bigger images, but the
dimensions will also increase, so that an image scanned at 160 DPI instead of 80 will be about twice as large3.

If you intend to print your images, a resolution of 300 DPI should be enough for most home printers. Increase
this value if you have a very high quality printer.

Higher values should be chosen only for specific uses, such as enlarged images on very high quality printers,
or quality scans of black and white originals. You will have to experiment a little until you’re satisfied with
the results.

3.7.3.2. OCR Software

By installing the kdegraphics-kooka and ocrad packages, you’ll be able to use Kooka, a simple graphical
front-end to SANE which is also able to perform OCR tasks. To launch it, choose Multimedia+Graphics→Kooka
from the main menu.

First choose the scanning device and then Kooka’s main window appears.

3. However scanning at a higher resolution and then reducing the resulting image size using graphic manipulation soft-
ware such as GIMP is one method often used to obtain better results than directly scanning at the desired final resolution.
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Figura 3-26. Kooka’s Main Window

Place the image you want to scan onto your scanner and click on Preview Scan at the bottom left of Kooka’s
window. For better results, you should choose the Grayscale Scan mode. Then adjust the resolution (200 DPI
should be enough), select the part of the image to be scanned and click on Final Scan.

To benefit from Kooka’s OCR features, you must configure it. Access the Settings→Configure Kooka menu, click
on OCR, and select the OCR engine you want to use.

Figura 3-27. Kooka’s Configuration Window

Once this is done you can click on this icon (Image→OCR Image) and click on Start OCR. The resulting
text will appear along with a spell-correction window.

Kooka is still in beta phase. Although it’s possible to make it work
properly you will need to adjust its parameters until you obtain a
decent rendering. For more information on Kooka please read its
handbook (Help→Kooka Handbook).
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3.7.4. Other Scanner Interface Software

Here is a list of other scanner interface software which is known to work under GNU/Linux.

• Users of the FLTK (“Fast Light Tool Kit”) graphic user interface could try FlScan (http://freshmeat.net/
projects/flscan/), a FLTK front-end for SANE.

• For EPSON scanners, you could download Image Scan! for Linux (http://www.avasys.jp/english/linux_
e/index.html), a scanner utility provided free of charge to GNU/Linux users by EPSON KOWA Corporation.

• While multi-functional HP devices are configured using PrinterDrake, owners of these devices should have
a look at the HP Linux Inkjet Project (http://hpinkjet.sourceforge.net/). The developers involved in
the project aim at providing GNU/Linux support for most Hewlett-Packard OfficeJet, PSC, LaserJet, and
PhotoSmart printer multi-function peripherals (MFPs).

3.8. Setting up your UPS

The role of a UPS (Uninterruptable Power System) is to provide you with electrical power whatever
happens. A UPS enables you to continue working for a certain amount of time due to its battery (up to 10
minutes usually depending on the model) even if there’s a power outage in your area. Its main function,
however, is to allow you to save your data and to cleanly close your machine, minimizing and even avoiding
data corruption and loss.

Open the Mandriva Linux Control Center in the hardware section and click on Set up a UPS for power monitoring
to launch DrakUPS.

The nut-server (“nut” stands for Network UPS Tool) package
needs to be installed.

Figura 3-28. DrakUPS Setup
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Next let DrakUPS autodetect your UPS. If all goes well you should get a congratulation message. If not try to
do it manually.

Select your UPS in the list of manufacturers and models.

Figura 3-29. Selecting the Manufacturer and Model

Then assign a Name, Driver, and Port4.

4. The Name and Driver fields should automatically be filled. Of course, you can change its name but we recommend you
keep the driver name.

52



Capítulo 3. “Hardware” Section

Figura 3-30. Name, Device and Port Names

If all went well your UPS should now be configured and ready to help avoid bad power outage surprises.
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4.1. Network and Internet Connection Management

Before connecting to the Internet, you are encouraged to set up
a firewall on your machine so as to avoid bad surprises such as
intrusions on your system. You can set up a very simple, yet effec-
tive, firewall using DrakFirewall. Please refer to Seção 7.3 for more
information.

The drakconnect set of tools allows you to easily configure your network access, whether it be to the Internet
or to a local network. Open Mandriva Linux Control Center and select the Network & Internet section to access
drakconnect tools. A view of the main interface is shown in Figura 4-1. The Internet connection sharing tool is
described in Seção 4.2.

Figura 4-1. DrakConnect Tools

4.1.1. Set Up a New Network Interface

drakconnect supports different types of Internet and network connections. The first step consists
in choosing which type of connection you wish to configure. Always make sure you have all the
information provided by your ISP or network administrator at hand.

4.1.1.1. LAN Connection

Select the LAN connection type and continue to the next step. Your NICs are detected automatically; if you
have more than one, you have to select the one you wish to configure. You can also load a driver for your NIC
manually.

Then, you have to specify if the network parameters will be automatically set up (Automatic IP (BOOTP/DHCP))
or not (Manual configuration): fill the next steps with the parameters which your ISP or network administrator
gave you. An example of the manual configuration of IP parameters is shown in Figura 4-2.
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Figura 4-2. Setting Primary Static LAN Connection Parameters

Check the Network Hotplugging box to have your network brought
up and down automatically when you connect and disconnect the
network cable. This is specially handy for laptop users.

Following with the static IP example, you have to specify the rest of the parameters, namely the hostname,
DNS server IP address(es) and the IP address of the machine giving you access to the Internet, known as the
gateway (see Figura 4-3).

Figura 4-3. Setting the DNS and Gateway IP Addresses

If you configure the network with DHCP you can optionally provide the machine’s hostname. Then you
can supply the Zeroconf hostname: this is the name which will be assigned to the machine when no network
configuration has been found.

After the configuration is done, you can bring the network connection up or down as described in Seção 4.1.4.
Please bear in mind that LAN connection types are set up to always be started at boot time.

An applet appears in the desktop’s panel indicating that the con-
nection is up

or down

. Right click on it to access a menu that will also let you
control the connection’s state as well as other parameters.

56



Capítulo 4. “Network & Internet” Section

4.1.1.2. Wireless Connection

This entry allows to configure WiFi PCMCIA or PCI devices.

1. Choose the card you wish to configure. If your card is not listed, choose the Use a Windows driver entry.
The next step then asks you to select the driver from the manufacturer’s card drivers CD.

2. Network configuration is then similar to the LAN connection type (see Seção 4.1.1.1).

3. Finally some wireless specific parameters are asked, make sure to set them correctly according to your
wireless access point configuration.

4.1.1.3. ADSL Connection

You will be asked which device your ADSL modem is connected to, select it and click Next.

You will then see a list of countries/ISPs. If yours is listed select it: most of the following parameters will be
automatically set. If your ISP is not listed, select the Unlisted - edit manually option, click on Next and fill the
parameters with the settings provided by your ISP.

You have to specify the connection type. The following options are available:

• DSL over CAPI. CAPI means Common ISDN Applications Programming Interface. This communication API
was mainly used for ISDN but is now also used for ADSL.

• Dynamic Host Configuration Protocol (DHCP). This is the usual cable-modem connection type used by ISPs
for ADSL. The rest of the configuration is the same as the one explained in Seção 4.1.1.1 (automatic configu-
ration option).

• Manual TCP/IP Configuration. This is rarely needed, but it is provided for flexibility. The rest of the configu-
ration is the same as the one explained in Seção 4.1.1.1 (manual configuration option).

• PPP over ATM (PPPoA). A protocol which encapsulates PPP frames in an ATM adaption layer (AAL5). A
common ADSL connection type, used mainly with USB ADSL modems.

• PPP over Ethernet (PPPoE). A protocol which encapsulates PPP frames in Ethernet frames. The most widely
used ADSL connection type. If unsure about yours, try this one first.

• Point-to-Point Tunneling Protocol (PPTP). It is Microsoft’s variation of PPP, used by some ADSL providers.
It is not considered a very secure protocol, and it’s not a RFC standard.

Figura 4-4. Setting the ADSL Connection Parameters

All the PPP types need at least a user name and a password. Here you can also specify the DNS servers, if
needed (see Figura 4-4). The required packages will be installed.
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Click on the Advanced button to be able to specify the VPI (Virtual
Path ID) and VCI (Virtual Circuit ID) numbers if needed.

You are then asked whether or not to bring the connection up at boot. Since ADSL connections are of the
“always up” type, you can safely select Yes. Finally you can test the connection: we strongly recommend you
to do so, to make sure all parameters are accurate.

4.1.1.4. Cable Connection

Some cable ISPs need you to authenticate. If this is your case, select the Use BPALogin option. If you are unsure
or don’t know, it is safe to select the None option.

Your NICs will be detected automatically. If you have more than one, you will have to select the one you wish
to configure. You can also manually load a driver for your NIC.

The rest of the configuration is very similar to the one described in Seção 4.1.1.1. Make sure you have all
needed parameters provided by your ISP handy.

4.1.1.5. ISDN Connection

Simply make sure to select the right parameters in all steps, concerning your area and provider.

The last step proposes to handle the connection status through the net applet, this can prove useful if you only
need the Internet connection from time to time.

4.1.1.6. Modem Connection

A list of detected modems is shown. If no modem was detected then only the Manual choice option is shown,
click on Next and choose the communications port the modem is connected to. The required packages will be
installed.

You will then see a list of countries/ISPs. If yours is listed select it and continue to the next step: some para-
meters (connection name, phone number to dial, and authentication scheme) will be automatically set. Verify
them, add the missing ones and accept them. If yours is not listed, select the Unlisted - edit manually option,
click on Next and fill the parameters with the settings provided by your ISP (see Figura 4-5).

Figura 4-5. Entering Dial-up Connection Parameters

All parameters should be obvious, except for the authentication type. The value in the Authentication pull-
down depends on what your ISP supports: Script-based (an old type of authentication method based on “ex-
pect” and “send” types of chat between your system and your ISP); Terminal based (a terminal window will
pop up when the connection is made and you will have to login interactively); PAP, CHAP, or PAP/CHAP
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(authentication information exchange protocols, CHAP is preferred because it is more secure, PAP/CHAP will
automatically choose the supported one).

Then come the IP, DNS and gateway settings. Nowadays, most ISPs provide them automatically when a
connection is made, so selecting the Automatic option on them is usually a safe bet. You will then be asked
whether you wish to allow users to start the connection. The safest choice is No. Otherwise any user will be
able to take the link down, therefore disconnecting every other user.

During the next step you will be asked whether to start the connection at boot time or not: it is probably safer
and cheaper to choose No. Finally you will be asked to test the connection: we recommend you to do so to
make sure all parameters are accurate. You can now control your Internet connection using the net applet. You
can also use the kppp remote access connection dialer (package kppp) through the main menu: Internet+Remote
Access→KPPP

4.1.1.7. DVB Connection

This conection type is used for satellite connections.

1. Choose the connection card you wish to configure, and then the adaptater settings.

2. Network configuration is then similar to the LAN connection type (see Seção 4.1.1.1).

4.1.2. Internet Settings

Figura 4-6. Configuring the Internet Access

This tool allows you to specify Internet access parameters if they need to be modified after your
initial configuration. Please bear in mind that these parameters are system-wide and apply to all
interfaces.
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4.1.3. Reconfigure Interfaces

Figura 4-7. Manage Network Connections

This tool permits you to modify network interface-specific parameters, after you have set them up
through the new interface wizard (see Seção 4.1.1). Use the drop-down list at the top to select the
interface you want to configure. The tabs allow you to change parameters and options according
to the network interface type selected.

This interface can be brought up by simple users through the net
applet just to monitor traffic.

4.1.4. Monitoring Connections

Figura 4-8. Real-Time Network Connection Monitoring

This tool shows the network interfaces activity. You can specify some options for the traffic graphic
and statistics: update interval, scale, etc (see Figura 4-8). It can also be used to control the status of
the network connection, bringing it up or down using the button at the lower left.
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4.1.5. Removing a Connection

This tool simply enables you to remove a network interface. Select the interface to be removed in
the Net Device pull-down list.

You will not be asked for confirmation. Once an interface is selected
for removal, pressing the Next button deletes it immediately.

4.1.6. Proxy Settings

This tool allows you to define the hostnames or IP addresses of proxies for the FTP and HTTP
protocols your computer will use. Fill the fields with the required values and click OK.

A proxy is a server which retrieves information from the Internet on your behalf, keeping a local copy of
the web pages which are most frequently requested. They are referred to as “caching proxies”, and optimize
bandwidth usage. In some organizations, you cannot access the Internet directly. You must pass through a
proxy which authenticates you before allowing you to connect to the Internet. This is usually combined with a
firewall which only guarantees the proxy direct access to the Internet. They are referred to as “authentication
proxies”. In corporate or business environments, proxies perform both caching and authentication functions
for performance and security reasons.

4.1.7. Wireless Connection Management

This tool shows the wireless networks currently available allowing you to switch between them.

4.2. Internet Connection Sharing

This tool configures your system so that it acts as a gateway to the Internet for other machines
connected to it via a LAN. This is very useful at home for example, if you wish all computers
to access the Internet through the same Internet link.
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Figura 4-9. A Simple Gateway Configuration

The overall procedure is the following:

1. Configure your Internet access (Seção 4.1). In order for your machine to act as a gateway, you will need an
already configured and working connection to the Internet, plus a network connection to your LAN. This
implies at least two interfaces, for example, a modem and an Ethernet card.

2. Setup the gateway (Seção 4.2.1)

3. Configure the other local machines as clients (Seção 4.2.2)

This wizard will also configure a firewall to block most connections
from the Internet. You are encouraged to check that the firewall
configuration (Seção 7.3) suits you after completing the wizard.

After you complete this wizard, all computers on the LAN will be able to access the Internet. Their configura-
tion will be automated due to the DHCP server which will be installed on your gateway, and the web access
will be optimized due to the use of the Squid transparent proxy cache.

4.2.1. The Gateway Connection Wizard

These are the steps that compose that wizard:

1. Choosing the Internet Interface

You first need to specify the name of the interface connected to the Internet. Make sure you select the
correct one: use the examples in the on-line help as a guide.

2. Choosing The LAN Network Adapter

If you have more than one Ethernet interface, and depending on what you chose as your Internet interface,
the wizard might ask you to select the one connected to your LAN. Make sure you select the correct one.
Note that all traffic to and from this network passing through the gateway will be masqueraded, that is: it
will appear to come from the gateway instead of from the LAN.

3. Local Area Network Settings
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Figura 4-10. Configuring The LAN

At this point, if it is the 1st time the system has been configured as a gateway, the wizard proposes default
parameters for the new local network to be managed. Check those values are not already in use in your
network, and go on to next step.

Otherwise, the wizard will first offer to reconfigure the LAN interface so that it will be compatible with
the gateway services. It is recommended that you leave the default options and click on Next. Then, all the
software needed will be installed.

4. DNS Configuration

If you plan on having a local name server on your machine, you can check the box. Otherwise you can
choose to use the name server of your provider. If you don’t know what is a name server, leaving the box
checked is safe.

5. DHCP Server Configuration

Installing a DHCP server on your machine will allow all client machines to have their network configu-
ration automatically done. Otherwise you will have to configure each of the clients by hands: IP address,
network, gateway, DNS.

6. Proxy Caching Server (SQUID)

A caching server records the Internet pages requested by local browsers. Then if the same page is asked
again by someone else, it’ll be able to serve it without needing to retrieve it again from the Internet, thus
saving bandwidth, and improving response time. This is most useful for many clients.

The application used to perform this task is Squid (http://www.squid-cache.org/).

When the wizard is completed, required packages are installed and configured.

4.2.2. Configuring the Clients

Configuration of the clients mainly depends on whether you chose to install a DHCP server on your gateway
or not. By configuring the clients on the local network to use DHCP, they will automatically use the Mandriva
Linux machine as a gateway to the Internet. This works for Windows®, GNU/Linux and any other OS which
supports DHCP.

If you have no DHCP server, you will have to configure each of your machines manually, according to the
network settings configured during the connection sharing wizard.

For DHCP, on a Mandriva Linux client system, make sure you selected DHCP in the Protocol pull-down list
when configuring the network as shown in Figura 4-11.
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Figura 4-11. Configuring a Client to Use DHCP
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5.1. Customizing your Menus with MenuDrake

In order to help you manage the main menu of your preferred graphical interface, Mandriva
Linux provides you with a menu editor which ensures menus from all desktop environments
(such as KDE or GNOME) are coherent.

This tool allows system administrators to control the menus for all users (the system menu) but can also be
utilized by users to personalize their own menus. You can launch MenuDrake from the Mandriva Linux Control
Center or from the System+Configuration+Other→Menudrake menu entry.

Figura 5-1. Launching MenuDrake in System or User Mode

If started by root, MenuDrake can be used in two different modes: either changing menus for all users, or
customizing the menus for user root. You will be able to switch from within the application thereafter, but
for now, click on:

• System menu to make changes to menus available for all system users;

• Root menu to customize the menus for the root user only.

When you launch MenuDrake, it first scans your current menu structure and displays it. The main window
(see Figura 5-2) is divided in two parts: the menu itself on the left, and a form relative to the highlighted menu
item on the right.
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Figura 5-2. MenuDrake’s Main Window

You can click on the tree’s [+] signs to view the content of the related sub-menus, and on [-] to hide them.

In your tree you may see entries which do not appear in your actual
menu. These are empty directories which are not displayed but can
be used for future applications which you may wish to install.

5.1.1. Adding a New Menu Entry

This should seldom happen as all Mandriva Linux graphical applications should provide a menu entry. Howe-
ver if you want to add a menu entry for a package you compiled yourself, or for a console mode program,
use this function. Let’s suppose you want to run the top command in a terminal window to view running
processes and the utilization of system resources through a menu entry in the System→Monitoring menu.

Select the System→Monitoring entry, and click on the tool bar’s Add application button. A dialog will appear
asking you for the title of the menu entry and the command associated with it.
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Figura 5-3. Adding a New Menu Entry

Edit the title (you could insert “Table Of Processes”) to be shown in the menu. Then you need to provide the
action the system should execute in the Command field: top. Click on OK and the entry will be added to the
menu tree.

You can also choose an icon for your entry from the list which appears once you click the icon button itself.
The new entry is shown in Figura 5-4. Do not forget to check the Open in a terminal box to have the program
run in a terminal window.

Figura 5-4. A New Menu Entry with MenuDrake

While modifying your menus, you might make a big mess out of
them... Remember that you can reload the menus as you last saved
them by pressing the Ctrl-R keys (or accessing the File→Reload
user config sub-menu). You can also revert to the default menus by
accessing the File→Reload system menu sub-menu.
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Finally to activate your modifications, click on the Save button and that’s it. Congratulations! You can now test
your new settings by accessing the main menu.

Depending on the graphical interface you are using, the changes to
your menu may not be shown immediately. In some cases, you may
need to log out and back in again for the changes to take effect.

5.1.2. Advanced Features

5.1.2.1. Different Menu Styles

Depending on the experience the users working with your machine have, you may want to provide them with
different menu styles. Mandriva Linux provides a few template menus which you can eventually customize.
They are available through the main window’s Menu Style button.

Figura 5-5. Choosing a Menu Style

Choose one of the available options:

• Use system administrator settings. If you started MenuDrake as a simple user, you can choose to set your
personal menu style to use the menus prepared by the system’s administrator.

• All applications. This is the traditional menu shipped with Mandriva Linux and it contains nearly all the
available applications, sorted into functional categories.

• What to do? Specifically designed by our ergonomics team, this menu provides a fast access to most com-
mon applications sorted by usage, such as Play a game, Use the Internet, etc.

• Original menu. These are the plain menus as provided by the KDE or GNOME desktops. This menu probably
lacks some applications.

When you have chosen a menu style, click on OK. You will then be able to see the corresponding menu
structure in the main window, and you can then customize it.
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5.1.2.2. About the Environment Menu

The entry we have just added to the menu is now available in the active graphical manager menu. It is also
possible to make modifications to all graphical manager menus by choosing Environment→All environments.

All entries which only apply to the active graphical environment appear in blue in the tree structure on the
left.

5.1.2.3. Moving and Removing Entries

MenuDrake entries support the drag-and-drop feature. Similarly, you may have noticed that whenever you
remove an application from the menu, it appears in the “attic”, that is the Available applications list on the
bottom right corner. If you ever wish to add them again, you simply have to drag them to the desired place in
the menu tree.

5.2. Configuring Start-Up Services

At boot time, the system starts a number of services (programs running in background to per-
form a variety of tasks). This tool gives the administrator control over those services. See the
Os Arquivos de Inicialização: init sysv chapter of the Manual de Referência for more information.

Figura 5-6. Choosing the Services Available at Boot Time

For each service, this is the list of items found in each column:

• Service name;

• Current Status: either running or stopped;

• Info: click on this button to get a little explanation about that service;
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• On Boot: check this box if you wish this service to be automatically brought up at boot time1. Alternatively,
if xinetd is installed and the service is a xinetd service, the label Start when requested will be displayed.
Checking the box will then mean to activate that service in xinetd. You will also have to make sure that the
xinetd service itself is activated.

• Start: immediately starts the service, or restarts it (stop+start) if it is already running;

• Stop: immediately stops the service.

For both the Start and Stop buttons, a tool tip will show you the status of the operation.

5.3. Managing Available Fonts on your System with DrakFont

This tool enables you to review the different font families, styles, and sizes available on your
system. It also allows the system administrator to install new fonts.

The main window (see Figura 5-7) shows a visual appearance of the currently selected font combination.

Figura 5-7. DrakFont’s Main Window

drakfont is made up of a number of windows which are accessible through the buttons located at the bottom-
left corner.

Options

Allows you to specify which applications and devices (such as printers) will support the fonts. Select the
ones you want support for and click on the OK button.

Uninstall

Allows you to remove installed fonts, in order to save space for example. Use this with great care, it could
have side effects on your applications. You should notably not remove fonts you did not install yourself.

1. Generally in runlevels 3 and 5.
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Import

Allows you to manually add fonts found outside the Mandriva Linux distribution, on a local Windows®

installation or from the Internet, for example. Supported font types are ttf, pfa, pfb, pcf, pfm, gsf.
Clicking on the Add button will open a standard dialog allowing you to specify the font file to import.
Once you’ve specified all the fonts you want to import, click on the Install fonts button.

To select more than one font, double-click on the first font you wish
to select and it will be added to the Import Fonts window. Then
double-click the other fonts you wish to install and the same action
will occur. When you are done click on the Close button and then
on the Install fonts button. Once the installation operation is done,
make sure the new fonts appear in the Family list.

5.4. Setting your Machine’s Date and Time

This little tool enables you to set your system’s correct internal date and time.

Figura 5-8. Changing Date and Time

You can set the date on the left and the time on the right:

• To change the year, click on the little arrows on each side of the year; same procedure to change the month.
This updates the month view where you can click on the current day in order to highlight it.

• We recommended that you check the time-zone settings for your geographical location. Click on the Change
Time Zone button and select the correct place in the tree view.

Once you’ve chosen the time zone, a dialog will appear asking you whether your hardware clock is set to
GMT. Answer Yes if only GNU/Linux is installed on your machine, No otherwise.

• To change the time, you can either move the hour, minute and second hands of the analog clock, or change
the numbers below it.
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• If you have a permanent Internet connection and want your system to synchronize its internal clock with
time servers on the Internet, put a check mark in the Enable Network Time Protocol option and select a server
in the Server pull-down list, preferably one near you. If you know the name or the IP address of a local server
you can also enter it manually in that field.

The NTP (Network Time Protocol) package needs to be installed.
If it isn’t, a dialog will pop up and ask you whether you wish to
install it.

If you select the pool.ntp.org server, NTP will automatically
choose a server near to the time zone you selected.

When you’re finished, click on OK to apply your settings or Cancel to close the tool, which will discard your
changes. If you want to return to your previous settings, click on Reset.

5.5. Monitoring System Activity and Status

This tool allows you to look for specific entries in various log files, therefore making easier the
search for particular incidents or security threats.

Additionally a nifty wizard allows you to set up mail alerts to be warned whenever the load is too high on
your machine, or when a service is shut down.

5.5.1. Browsing System Logs

Figura 5-9. Browsing and Searching through System Logs
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These are the steps to follow in order to browse or look for a specific event into the system logs:

1. You must choose which specific words to match by filling the Matching (log files contain the words) field
and/or the but not matching (log files which don’t contain the words) field. At least one of the two fields
must be filled.

2. Then in the Choose file area select the file you want to perform the search on. Simply check the correspon-
ding box.

The Mandriva Linux Tools Log is filled by Mandriva Linux-specific
configuration tools, like those you find in the Mandriva Linux Con-
trol Center. Each time these tools modify the system configuration
they write a line in this log file.

3. Optionally, you can restrict the search to a specific day. In that case, check the Show only for the selected
day box and choose the desired day from the calendar.

4. When all is set up, click on the Search button. The results will appear in the Content of the file area at the
bottom.

Clicking on the Save button will open a standard dialog letting you save the search results into a plain text
(*.txt) file.

5.5.2. Setting up Mail Alerts

In order to facilitate server monitoring, Mandriva Linux supplies a simple tool which sends automatic mail
alerts whenever something goes wrong on your server.

Clicking on the Mail alert button of the LogDrake main interface (see Figura 5-9) starts the wizard. First you’re
asked whether you wish to configure or stop the mail alert system. Choose Configure the mail alert system entry
in the pull-down list, and click Next.

Figura 5-10. Setting up a Mail Alert: Services

The next step (see Figura 5-10) allows you to select the services you wish to receive alerts from in case they
stop working. Simply check the service boxes which interest you, and go on to the next step.
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The services listed are the ones present on your system. Here’s a
list of the currently tracked ones:

� Postfix Mail Server;

� Webmin Service;

� FTP Server;

� BIND Domain Name Resolver;

� Apache World Wide Web Server;

� SSH Server;

� Samba Server;

� Xinetd Service.

Figura 5-11. Setting up a Mail Alert: Load

Select the load you which you consider unacceptable by moving the Load slider (see Figura 5-11). A high
system load may indicate that a process has gone out of control, or simply that there’s a very high demand
on this machine. Therefore a service is suffering from it and is delayed. As a rule of thumb, the load on your
computer should not exceed 3 times the number of processors you have on it.
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Figura 5-12. Setting up a Mail Alert: Recipient

Finally you need to tell the system to whom these alerts should be sent to (see Figura 5-12). Provide an e-mail
address and the mail server (local or on the Internet) to relay the alerts to.

When the wizard is finished, an hourly check is set up to check for unavailable services and the system’s load.
If needed a mail alert is sent to the alerts’ recipient.

5.6. Access to the Console

This tool simply opens a virtual terminal console for the root user. You can use it to issue any
command, but be careful! There are no restrictions on the actions you can take on your machine
as root, and you could render your machine unusable.

To learn how to use the command line interface, you should read the Introdução a Linha de Comando chapter
of the Mandriva Linux Manual de Referência . To exit the console, type exit or press Ctrl-D.

5.7. Managing Users and Groups

UserDrake allows system administrators to easily add and remove users from the system, to assign users to a
group, and to manage user groups in the same manner.

In this section we will only focus on user management. Group ma-
nagement being similar.

5.7.1. The Interface

Launching UserDrake will display the main window (Figura 5-13) which lists the users currently defined on
the system. You can switch from users to groups by clicking on the Groups tab next to the Users tab.
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Figura 5-13. The User List in UserDrake

All changes have immediate effect on your local user database. If the user list is modified outside of UserDrake,
you can refresh UserDrake’s window by clicking on the Refresh button.

If you make changes to an already logged in user, those changes
won’t take effect until he or she logs out, and logs in again.

Available actions are:

Add User

Adds a new user to the system. We will detail this procedure in Seção 5.7.2.

Add Group

Adds a new user group to the system.

Edit

Allows you to change the parameters of the selected user or group. We will detail editing user parameters
in Seção 5.7.2. In the case of a group you will be able to assign or remove users from that group.

Delete

Removes the selected user or group from the system. A confirmation dialog will be shown, and in the
case of a user you will also be able to remove the user’s /home directory and mailbox.

5.7.2. Adding a New User

We created the non-privileged user Queen Pingusa at installation time, and now we want to create a new user
called Peter Pingus. Then we want to make them both members of the fileshare group, so that they can
share folders with other users on the network (see Seção 6.5, custom option).

Click on the Add User button, the dialog box to add a new user will pop up (see Figura 5-14). The only required
field is Login although we strongly recommend that you set up a password for this new user: enter it in both
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the Password and Confirm Password fields. You can also choose to add a comment in Full Name. Generally, this
is the full name of the user, but you can put whatever you want.

Figura 5-14. Adding a New User in the System

We now have two users in our list. Select one of them with your mouse, and click on the Edit button. The
dialog box shown in Figura 5-15 will pop up. It allows you to modify most available user parameters.

Figura 5-15. Adding Users to a Group

The dialog is made of the following tabs:

User Data

Allows you to modify information provided when the user was created.

Account Info

Enables you to provide an expiration date for that account, after which the user won’t be able to connect
to the system. This is useful for temporary accounts. It’s also possible to temporary lock an account to
prevent a user from logging in. Finally, this tab allows you to change the icon associated with the user.

Password Info

Allows you to provide a password expiration date, after which the user will have to change his password.
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Groups

Shows the list of available groups where you can select the groups to which any user should belong.

For our users we just need to look for the fileshare entry and check the box associated to it. Then click on
the OK button to make the changes effective.

5.8. Backing Up and Restoring your Files

This tool allows you to back up data present on your computer on different media and on
a remote machine over the network. Once the parameters are set, you can run the backup
periodically. Then, you can forget about it until you wish to restore some files.

The backup parameters must be defined so that the tool knows what, where and when to perform the backup.
We will guide you step-by-step with a back up-and-restore example using the wizard. Then we will introduce
you to automation of periodic backups.

5.8.1. A Practical Example Using the Wizard

You can access this tool by clicking on the Backups icon in Mandriva Linux Control Center’s System section. Click
on the Wizard Configuration button to start the wizard. After making your choices in each step click on Next.

5.8.1.1. First Step: What to Backup

Figura 5-16. Selecting What to Backup

Select Backup System to include the /etc directory where all your current system configuration files lie. This
allows you to “transport” your system to a different computer with little effort: only hardware-dependent
configuration will have to be revised.
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The“system”backup does not include applications themselves (i.e.
executable files, libraries). A priori this makes sense because it is
likely that you will have access to the system’s installation media
from which applications can be easily installed again on the target
computer.

Select Backup Users to include all the files included in all of your users’ /home directories. Clicking on the Select
user manually button lets you select individual users and give you the following options:

• Do not include the browser cache. Selecting this option is recommended due to the very nature of the ever-
changing browser’s cache.

• Use Incremental/Differential Backups. Selecting this will preserve old backups. Choosing Use Incremental Bac-
kups will only save files which have been changed or added since the last backup operation. Choosing Use
Differential Backups will only save files which have been changed or added since the first backup operation
(also known as the “base” backup). This last option takes more space than the first one, but allows you to
restore the system “as it was” at any given point in time for which a differential backup was made.

5.8.1.2. Second Step: Where to Store the Backup

Figura 5-17. Selecting Where to Store the Backup

All possible backup media are listed, along with a Configure button to change media-dependent options:

Hard Disk Drive

The local hard disk drive is used to prepare backups for all media except NFS and direct to tape. You
should not perform backups on your local hard disk anyway, you should always backup on remote or
removable media. You can set the directory for storage and the limit of storage space. You can also set
how many days to keep incremental or differential backups in order to save disk space.
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Across the Network

To store the backup on a remote computer accessible using different methods. You can set the connection
parameters as well as the access method and its options (if applicable). Please note that NFS backups are
considered to be local disk backups, even if they are effectively stored on a remote system.

On Tape

To store the backup on a tape drive. You can set the tape device if it’s not detected automatically, and tape
parameters such as writing directly on tape, whether or not to rewind, erase and eject the tape.

Optical Media (CD-R)

To store the backup on optical media: (re)writable CD or DVD. This is our preferred media for the exam-
ple, so click on its Configure button to set the required parameters (see Figura 5-18).

Figura 5-18. Setting Optical Media Parameters

If it isn’t done automatically, use the Choose your CD/DVD device combo box to set the CD/DVD device. Set
the medium’s type and size, multisession and erasing options.

For multisession recordings, please have in mind that the option to erase the medium is only effective for the
1st session and also that session-related information recording takes some space out (20 to 30 MB) for each
session, so the “real data” storage space will actually be less than the medium’s size.
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5.8.1.3. Third Step: Review and Store the Configuration

Figura 5-19. Review Configuration Parameters

The last wizard step shows a summary of the configuration parameters. Use the Previous button to change any
parameter you are not satisfied with. Click on Save to store them. The backup set is now ready to be performed.

5.8.1.4. Performing the Backup

Click on Backup Now, make sure the corresponding media is ready (the recordable CDs in our example), and
then on Backup Now from configuration file to perform the backup.

If the backup set size exceeds the medium’s available capacity, the
backup operation might just fail. This is a known issue and it’s
being worked on. As a work-around, please try to remove files from
the backup set so its size never exceeds the medium’s available
capacity.

A dialog will display the current progress of the operation. Please be patient: the time it takes to back up
depends on many factors such as the size of the backup file set, the speed of the storage option selected,
and so on. Once the operation is finished a report is shown: look for possible errors on it and take corrective
measures if needed.
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5.8.2. Restoring Backups

Figura 5-20. Choosing the Restore Type to Perform

Make sure the media you want to restore the backup from is accessible and ready and click on the Restore
button. In our example we will restore the whole backup so on the restore dialog (Figura 5-20) click on Restore
all backups and then on the Restore button to start the restoration process.

Existing files in the target restoration directory (same location whe-
re the backup was made from, by default) will be overwritten.

Feel free to investigate the other restore options if you want to restore part of a backup instead of the full file
set.

5.8.3. Automating Periodic Backups

In the tool’s main window, click on Advanced Configuration and then on the When button. In The backup
scheduling window (see Figura 5-21) select Use daemon to define the schedule.
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Figura 5-21. Daemon Options Window

You are then asked to specify the interval (or period) between each backup operation and the storage media.
In our example we set up a customized calendar (custom period selected) to perform a backup every Friday at
a quarter to midnight and store it on CD.

5.8.4. Advanced Drakbackup Configuration

Click on Advanced Configuration and then on the More Options button to set more backup options (see Figura
5-22).
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Figura 5-22. Miscellaneous Options Window

Use the Please choose the compression type pull down list to select the compression used for your backups
among tar (no compression), tar.gz (gzip compression) and tar.bz2 (bzip2 compression: better but
slower).

Select the Use .backupignore files option to have certain files excluded from the backup. The .backupignore file
should be present in every directory of the backup file set where files are to be excluded. Its syntax is very
easy: a one-file-per-line list of the names of the files to exclude.

You can use the star (* =“matches any string”) and the question
mark (? =“matches one and only one character, regardless of what
that character is”) in the .backupignore file to exclude sets of files.
For example, somename* matches all files whose names start with
somename, and image00?.jpg matches files named image001.

jpg, image009.jpg, image00a.jpg, image00h.jpg, etc.

Select the Send mail report after each backup to option and fill the e-mail address so the tool knows to whom
to mail the backup operation report. Please bear in mind that the system needs to have a working MTA (Mail
Transport Agent) for this option to be effective.

Select the Delete Hard Drive tar files after backup to other media option to free that space after performing the
backup.
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6.1. Managing your Hard Drive Partitions with DiskDrake

Partitions are initially set up during the installation process. DiskDrake allows you, to some
extent, to resize your partitions, move them, etc. DiskDrake can also deal with RAID devices
and supports LVM but we will not discuss these advanced uses here. Please refer to the Guia
de Referência to learn more about what partitions are used for.

DiskDrake is very powerful and can therefore be a dangerous tool.
Misuse of it can very easily lead to data loss on your hard drive.
Because of this potential loss of data, you are strongly advised to
take some protective measures before using DiskDrake:

1. Back up your data. Transfer it to another computer, ZIP
disks, etc.

2. Save your current partition table (the table describing
the partitions held on your hard drive(s)) to a floppy disk
(see Seção 6.1.2).

6.1.1. The Interface

Figura 6-1. DiskDrake’s Main Window

DiskDrake enables you to configure each physical hard drive on your machine. If you only have one IDE disk,
you will see a single tab called hda below the file-system types. If there is more than one drive, then each drive
will have its own tab and will be named according to the Linux name for that drive. DiskDrake will allow you
to manage the partitioning of each drive.

The window (see Figura 6-1) is divided into four zones:

• Top. The structure of your hard drive. When you launch DiskDrake it will display the current structure of
the drive. DiskDrake will update the display as you make changes.

• Left. A menu relevant to the partition currently selected in the above diagram.

• Right. A description of the selected partition.

• Bottom. Buttons for making general actions. See next section.
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We will now review the actions available through the buttons at the bottom of the window, and then describe
a practical use case.

6.1.2. DiskDrake’s action buttons

Clear all

Clicking on this button will clear all partitions on the current hard drive.

More

Displays a three button dialog allowing you to:

Save partition table

Allows you to save the current partition table to a file on a disk (a floppy, for example). This may
prove useful if a problem arises (such as an error made during drive repartitioning).

Restore partition table

Allows you to restore the partition table as previously saved with Save partition table. Restoring a par-
tition table may recover your data as long as you do not reformat partitions, because the formatting
process will overwrite all your data.

Rescue partition table

If you lose your partition table and have no backup, this function scans your hard drive to try and
reconstruct the partition table.

Help

Display this documentation in a browser window.

Undo

Cancels last action. Most modifications done on your partitions are not made permanent until DiskDrake
warns you it will write the partition table. This button therefore allows you to undo all of your modifica-
tions on partitions up to last write.

Toggle to expert mode

This button allows you to access the expert mode functions (which are even more dangerous if you are
not sure what you are doing). Reserved for experts.

Done

Saves your changes and exits DiskDrake.

6.1.3. Resizing an Old Partition and Creating a New One

In this section, we are going to do a little exercise to demonstrate one of the more useful features of DiskDrake.
Let us imagine that you decide to use your machine as an FTP server and you want to create a separate
/var/ftp partition in order to host the FTP files. Note that doing this step-by-step tutorial will actually
modify the structure of your hard drive.

This is what the current /home partition looks like (see Figura 6-2), before any modification. We are going to
shrink this partition in order to create free space for the new file system.
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In order to perform the steps in this example, all users of your
system must be logged out, except root.

First of all, you need to unmount the /home partition by clicking on it and then pressing the Unmount button.

Figura 6-2. The /home Partition Before Resizing

The next step, as you may have guessed, is to click on the Resize button. A dialog will appear (see Figura 6-3)
which will allow you to choose the new size for the /home partition. Move the slider to reflect the new size,
then click on OK.

Figura 6-3. Choosing a New Size

When this is done, you will notice that the graphic representation of your hard drive has changed. The
/home partition is smaller, and an empty space appears on the right. Click on the empty space and then on
the Create button which appears. A dialog (see Figura 6-4) will let you choose the parameters for the new
partition. Set the size, choose the file system you want to use (usually Journalized FS: ext3) and then
enter the mount point for the partition, which in our example will be /var/ftp.

Figura 6-4. Defining the New Partition

Figura 6-5 shows what our projected partition table now looks like.

87



Capítulo 6. Pontos de Montagem e Diretórios Remotos

Figura 6-5. The New Partition Table

The last step is to format (prepare to host files) the newly created partition. To format the partition, click on its
representation in the partitions picture, then on the Format button. Confirm the writing of the partition table
to disk, the formatting of the partition and the update to the /etc/fstab file. You may be asked to reboot the
computer to make changes effective.

Figura 6-6. Confirming the Writing of the Partition Table

6.2. Managing Removable Devices

These tools enables system administrators to easily control most options which affect the beha-
vior of removable devices such as floppy, CD and DVD disks. Note that, by default, all remo-
vable devices are automatically made available so users shouldn’t have to manually mount
media.
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Figura 6-7. Changing a Parameter

For each device the following properties may be changed:

• Mount point. The directory where the device’s files will be accessible from. You can either choose an entry
in the list or type in your own path. If the directory does not exist, it will be automatically created.

• Options. Controls various device options, notably whether it is mounted automatically (supermount) or not.
Note that if the supermount option is selected, the two others (user and noauto) must not be selected.

• Type. Displays a list of file-system types. If you have a specific medium with an uncommon file system on
it, this is where you can tell Linux how to access it.

Select the property you wish to change and click on OK. The corresponding dialog will pop up in which
you can change your settings. Then click on OK again. The system will then ask you if you want to save the
modifications in the /etc/fstab file. By saying yes, you will not have to unmount and re-mount that device:
it will be done automatically

6.3. Importing Remote SMB Directories

This tool allows the system administrator to import remote shared directories based on the
SMB protocol (used mainly by Windows®) on the local machine.

While users can individually access remote shares through their file managers, it may be required in some ca-
ses to import a specific share for it to become immediately available for all users. We’ll go through an example
showing you how to import a template directory from a Windows®machine.

89



Capítulo 6. Pontos de Montagem e Diretórios Remotos

Figura 6-8. Scanning the Whole Network

Clicking on the Search servers button scans the local network for machines which currently share directories
(including the local one). In our example, many servers are available. We’ll choose skywalker and we’ll make
it available locally for all users.

Clicking on a machine’s name will try to connect to it and browse for available shares. If that machine has
password-protected shares, a dialog will pop up asking you to identify yourself.

Figura 6-9. Authenticating on a Remote Samba Server

Enter the correct Username, Password and Domain. The available shares on that machine will then appear. Click
on the little arrow on the left of the server icon to show available shares.

If the machine you’re connecting to has both public and password-
protected shares, then canceling the password entry dialog will con-
nect you to that machine, but only to its public shares.

Figura 6-10. Choosing the Remote Directory to Import

Once a share is selected, a Mount point button appears. Clicking on it displays a dialog where you can type the
local directory name where remote files will be accessible.
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Once this is done, two more buttons appear:

• Mount. Makes the resource available locally. When this is done, users simply have to point their file manager
to the directory selected as the mount point to get the files hosted by the server.

• Options. Allows you to set a user name and password to access that SMB mount point. Other permissions
and advanced settings can also be set through this button.

Also, the little icon in front of the shared directory becomes

When you’re finished configuring the access points for remote directories, click on Done. A dialog box will
appear asking you whether you wish to save your modifications to the /etc/fstab file (where mount point
information is usually stored), or not. Click on Yes to make the shares configuration persistent between ses-
sions. Click on No to exit without saving your changes.

6.4. Importing Remote NFS Directories

This tool is exactly the same as the one mentioned in Seção 6.3, except that it controls file
sharing through the NFS protocol rather than SMB. Therefore it allows you to locally import
shared files from NFS-friendly machines. The interface is the same as the one described in
Importing Remote SMB Directories, and the effects are similar. Only the corresponding machines
are different: UNIX® for NFS and Windows® for SMB.

Another difference is that there is no need to provide a password to access NFS shares. The authentication
mechanism is host-based.

6.5. Allowing Users to Share Folders

This tool enables you to share files with other users of your computer network. File sharing
can be done on heterogeneous systems such as GNU/Linux and Windows®.

The file-sharing configuration is done in two simple steps: determining who can export folders, and then
which protocol to use. A 3rd step is necessary if you select the Custom export option.

Figura 6-11. Controlling Exports

First of all, you must determine who will be able to share folders. Here are the different available options:
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• No sharing. Prevents users from sharing data with others.

• Allow all users. All users are allowed to share data with others.

• Custom. By choosing this option, only users within the same fileshare group will be allowed to share
data. If you choose this option, the fileshare group will be created and, as a 3rd step, you will be prompted
to run UserDrake in order to add the allowed users to this group (see Seção 5.7).

Figura 6-12. Choosing the Export Protocol

Then you must choose which protocol to use for file sharing. Check one or both of the following:

• SMB. If you want your users to share files using Windows® systems.

• NFS. If you want your users to share files using UNIX® systems (such as GNU/Linux).

Once you have checked the appropriate boxes, click on OK. The required packages will be installed, if needed.
If you uncheck a previously checked box, the corresponding service will be stopped.

Once users are allowed to share data, they can select the folders to be shared through their preferred file
manager.

6.6. Setting up WebDAV Mount Points

WebDAV (Web-based Distributed Authoring and Versioning) is an extension to the HTTP protocol
which allows you to create, move, copy, and delete resources on a remote web server. In prac-
tice, mounting a remote WebDAV repository on your local machine will allow users to modify
a remote web server’s files as if those files were local to the system.

Browse the WebDAV Resources (http://www.webdav.org/) pages
to learn more about this protocol.
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Figura 6-13. Managing WebDAV Mounts Points

The first time you launch this tool the required packages will be installed if needed, and only two buttons
will be available. New, which allows you to define a new mount point, the other one just Quits the application.
After you have defined mount points, they will appear as new buttons at the top of the buttons list. Clicking
on a mount point button will get you to the mount point menu (see Figura 6-14).

When you click on the New button you are asked for the URL of the web server. Enter the complete URL of
the web server, beginning with http:// or https://, then click OK.

Figura 6-14. WebDAV Menu

You must now decide where the web server files will be accessible from. Select the Mount point option and
click OK. There you will be able to choose a local directory or type in your own. If the selected mount point
does not exist, it will be created.

If the server requires authentication, do not forget to fill the username and password fields in the Options dialog.
Then all you need to do is to actually mount the remote repository by selecting Mount and clicking OK.

You will now be able to browse and modify files on the local mount point you have defined and the changes
will be immediately available on the web server.
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To make your settings persistent between sessions, do not forget to save modifications to the /etc/fstab file,
as suggested when you quit the wizard.
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7.1. Securing your Machine through DrakSec

draksec is a graphical interface to msec (which stands for Mandriva Linux Security Tool). It
allows you to change your system’s security level and to configure every option of msec’s
security features.

msec has two aspects: system behavior configuration and periodic checks of system state. Each security level
modifies the system configuration, making it more and more secure, and verifying more and more security
related aspects.

7.1.1. Setting your Security Level

This tool is only displayed in expert mode. Choose Options→Expert
mode from the menu and then access the Security section of Man-
driva Linux Control Center.

Figura 7-1. Choosing the Security Level of your System

Simply choose the security level you want from the Security Level pull-down list: it will be effective as soon
as you click on OK. Please read the help text regarding security levels very carefully so that you know what
setting a specific security level implies.

If you wish to check which options are activated for each security
level, review the other tabs: Network Options, System Options and
Periodic Checks. Click on the Help button to display information
about the options and their default values. If some of the default op-
tions don’t suit your needs, simply redefine them. See Seção 7.1.2,
for details.
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Put a check mark on the Security Alerts box to send by mail possible security issues found by msec to the local
user name or to the e-mail address defined in the Security Administrator field.

We highly recommend you activate the security alerts option so
that the administrator is immediately informed of possible security
issues. Otherwise the administrator will have to regularly check the
relevant system log files.

7.1.2. Customizing a Security Level

Clicking on each of the Options tabs (and the Periodic Checks one) lead you to msec’s list of security options.
This allows you to define your own security level based on the security level previously chosen.

Figura 7-2. Modifying Standard Options

For each tab, there are two columns:

1. Options List. All available options are listed.

2. Value. For each option1 you can choose from the corresponding pull-down menu:

• Yes. Activate this option no matter what the default value is.

• No. Deactivate this option no matter what the default value is.

• Default. Keep the default security level behavior.

• Ignore. Use this option if you don’t wish that test to be performed.

• ALL, LOCAL, NONE. The meaning of these are option-dependent. Please see the Help text available
through the Help button for more information.

Clicking on OK accepts the current security level with custom options, applies it to the system and exits the
application.

1. The default security level setting is shown in the Help window.
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7.2. Controlling File Permissions with DrakPerm

In Seção 7.1, you saw how to change your system’s security level and customize the security checks associated
to those levels.

drakperm allows you to customize the permissions which should be associated with each file
and directory in your system: configuration files, personal files, applications, etc. If the owners
and permissions listed here don’t match the actual permissions of the system’s files, then msec
(which stands for Mandriva Linux Security Tool) will change them during its hourly checks.
Those modifications can help prevent possible security holes or intrusions.

This tool is accessible only in expert mode. Choose Options→
Expert mode from the menu and then access the Security section
of Mandriva Linux Control Center.

Figura 7-3. Configuring File-Permission Checks

The list of files and directories which appears depends on the current system’s security level as set by msec,
along with their expected permissions for that security level. For each entry (Path) exists a corresponding
owner (User), owner group (Group) and Permissions. In the drop-down menu, you can choose to display only
msec rules (System settings), your own user-defined rules (Custom settings) or both as in the example shown in
Figura 7-3.

You cannot edit system rules, as stated by the“Do not enter” sign
on the left. However you can override them by adding custom rules.

If you wish to add your own rules for specific files or modify the default behavior, display the Custom settings
list and click on the Add a rule button.
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Figura 7-4. Adding a File-Permissions Rule

Let’s imagine your current security level is set to 3 (high). This means that only the owners of the home
directories can browse them. If you wish to share the content of Queen’s home directory with other users, you
need to modify the permissions of the /home/queen/ directory.

msec only changes file permissions that are more permissive than
the one required by a certain security level. That means that for
the change above, the permissions must be changed by hand.

You can do that in Konqueror by modifying the permission
properties of your home directory, and checking the Apply changes
to all subfolders and their contents option.

If you create more rules, you can change their priorities by moving them up and down the rules list: use the
Up and Down buttons on your custom rules to have more control over your system’s permissions.

7.3. Protegendo sua Conexão Internet com o DrakFirewall

Esta pequena ferramenta permite a configuração de um firewall básico para sua máquina. Ele
filtra tentativas de conexão vindas de fora e bloqueia as que não forem autorizadas. É recomen-
dado que a ferramenta seja executada logo após a instalação da máquina e antes de se conectar
à Internet, minimizando portanto os riscos da sua máquina ser comprometida.
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Figura 7-5. A Janela do DrakFirewall

Se estiver marcada, desmarque a opção Todos (sem firewall) e marque as opções correspondentes aos serviços
que você deseja tornar disponíveis para o mundo externo. Se você desejar disponibilizar um serviço que não
está listado aqui, clique no botão Avançado para especificar manualmente as portas que devem ser abertas.

O botão Avançado faz surgir um novo campo chamado Outras
portas onde você pode digitar o número da porta e seu protocolo
que deve ser aberta para o mundo externo. Alguns exemplos são
apresentados logo acima deste campo: use-os como guia. É ainda
posśıvel especificar faixas de portas usando a syntaxe : como em
24300:24350/udp.

Não marcar um serviço nesta lista não impedirá uma conexão sua para o serviço. Irá apenas impedir conexões
vindas da Internet para este serviço na sua máquina. Se você não planeja hospedar serviços na sua máquina
(caso comum para máquinas domésticas ou desktop), deixe todas as opções desmarcadas.

Por outro lado, caso você deseje desabilitar o firewall e deixar todos os serviços acessíveis para o mundo
externo, marque a opção Todos (sem firewall) mas, por favor, tenha em mente que isto é bastante inseguro e
não recomendado.

Após clicar no botão OK, o próximo passo será selecionar qual a interface que conecta sua máquina à Internet.
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Figura 7-6. A Interface Internet

Analise os exemplos para determinar o nome da sua interface que está conectada à Internet. Se não tiver
certeza, consulte a configuração de rede do sistema (veja Seção 4.1.3). Por fim, clique no botão OK para instalar
os pacotes necessários, ativar o firewall e aproveitar sua conexão protegida.
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8.1. Configuring the Login Mode

This tool allows a user to be automatically logged into the system at boot time, without a
password being required.

Figura 8-1. Choosing the Login Mode

There are a few parameters:

1. Graphical interface: if you wish to have the X Window System (graphical display) started at boot time,
check the Launch the graphical environment when your system starts box. If you leave it unchecked, the text
login will be displayed and you will need to start the graphical environment manually.

2. Autologin: if you’re the only person using your machine and nobody else has access to it, you may choose
to be automatically logged in at boot time. To do so, select the Yes, I want to autologin with this (user,
desktop) option. Then choose the user you want to be logged on automatically in the Default user, as well
as the preferred Default desktop in the pull-down menus.

8.2. Changing your Bootup Configuration

This tool allows you to configure the bootloader and the boot menu entries.

Unless you’re an expert, it’s not recommended to change these
settings as this may prevent you from booting your machine the
next time you try to power it on.
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Figura 8-2. Choosing the Boot Mode

8.2.1. Configuring the Bootloader

You can choose between the GRUB and the LILO bootloader. Either one will allow you to boot Mandriva Linux,
it’s just a question of taste.

Unless you know what you’re doing, you shouldn’t change the default Boot device shown, since that’s where
the bootloader installs itself. If more than one OS is installed on your machine, it’s a good idea to leave at least
5 seconds so that you can easily select a different menu item than the default image.

The dialog finally shows a few options which can be useful depending on your specific hardware.

Enable ACPI

Enable this option to allow better power management support if your hardware is ACPI compatible.
ACPI is often needed for new laptops which no longer support APM.

Force No APIC

The IO-APIC (http://www.wlug.org.nz/APIC) is only really useful for multi-processor systems. It may
cause problems on single processor systems and should be deactivated in that case by checking this box.

Force No Local APIC

The Local APIC can be used by Linux to program interruptions to wake up threads. On multi-processor
machines it can be used to send interrupts to another processor.

These relatively new APIC features are known to cause problems on some computers because of badly desig-
ned chip sets or poor support in Linux kernel drivers. These problems can cause system freezes or incorrect
device detection. So you may need to deactivate them by checking the corresponding box.

Click on Advanced to be able wipe the contents of the /tmp directory (which might hold some files you down-
load from the Internet, for instance) and to tell Linux how much RAM your machine uses should this prove to
be an issue at boot time.

8.2.2. Managing Boot Entries

After clicking Next, the list of available entries at boot time is displayed; the default one is marked by a star
(*).

It’s also possible to make an entry the default one by checking the Default checkbox in the Modify dialog.
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8.3. Customizing your Boot Theme

The Boot Theme utility enables you to change the default theme displayed at boot time, as well
as a few other options.

• Choose one of the available boot modes in the pull-down menu (Figura 8-3).

• Uncheck the Display theme under console option if you want a clean, “traditional” console. This relates to
those accessible through the Ctrl-Alt-Fn keys.

Figura 8-3. DrakBoot Theme Window

The boot theme setting will have no effect if your system isn’t set to boot using the graphical mode. Please
refer to Seção 8.2, for more information on setting the boot mode.

If you only have one theme available, you can install the bootsplash-themes package which you will find in
contribs. Other themes are also available on the web.

The Create new theme button allows you to fully customize an existing boot theme or create a new boot theme
from scratch. Adjust the parameters to your liking and save it. It will then be accessible in the available Themes
list.
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